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Chapter 1: Getting Started
 

This guide contains all the necessary information for configuring and initiating 
the WANSync application, synchronizing, replicating and distributing data, 
monitoring and reporting, and of course, switchover and recovery.

About WANSync contains important general information about the WANSync 
products, their various modules, and a list of key features. 

The WANSync Solution contains important information about how WANSync, 
WANSyncHA and WANSyncCD work, and how the various modules function in 
the replication process. 

To get up and running quickly, you may begin with Creating Replication 
Scenarios and continue reading through to the end of Recovery. It is also 
recommended that you read the appropriate operations guide (you can find the 
most up to date operations guides for each application on www.caxosoft.com 
under the Support menu).

Installing WANSync on Microsoft (MS) Windows explains installing, upgrading, 
and un-installing the WANSync application.

Important! This manual applies to WANSync Server, WANSync Exchange, 
WANSync Oracle, WANSync SQL, WANSyncIIS, WANSyncHA products (which 
include all the capabilities of WANSync) and WANSyncCD. Throughout this 
document, the term WANSync refers to all products, unless otherwise specified.

Related Documentation
Use the following guides along with this user guide:

WANSync SQL Server Operations Guide

WANSync Exchange 200x Operations Guide

WANSync Red Hat Server Operations Guide

WANSync Solaris Server Operations Guide

WANSyncHA Exchange 200x Operations Guide
Getting Started    1

http://www.xosoft.com
www.xosoft.com


Terms and Abbreviations
WANSyncHA SQL Server Operations Guide

WANSyncHA Oracle Server Operations Guide

WANSyncHA File Server Operations Guide

WANSyncHA IIS Server Operations Guide

WANSyncHA for BlackBerry Enterprise Server Operations Guide

White papers offering a broader introduction to disaster recovery, business 
continuity and content distribution solutions using WANSync and WANSyncHA 
are also available on the CA XOsoft website: www.caxosoft.com.

Terms and Abbreviations
The following terms and abbreviations are used throughout the document. 
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Terms and Abbreviations
Terms

Term Definition

Bookmark Checkpoint that is manually set in the Rewind log to mark a 
state that you may want to rewind back to. Usually set before 
a major set of operations is performed on the data. 

Data Rewind Data recovery solution that uses the rewind points or 
bookmarks in the Rewind log to reset the current data back 
to a previous state. 

Master Main or production server where database and file activities 
are taking place. The server in the replication scenario that 
you want to replicate.

Node A master or replica host in a replication scenario tree.

Recovery Process of retrieving lost or corrupted master data from any 
replica by activating a synchronization process in the reverse 
direction.

Replica Server set up to receive replication data from a master 
server.

Replication Real-time capture of changes to files and databases on a 
master server and transfer to its replica server(s).

Replication Tree The connection scheme of replication from master host to its 
replica host(s) represented as a tree.

Rewind point Checkpoint in the Rewind log marking an event or operation. 
The actual information stored includes the operation that will 
undo the event, in case the rewind point is activated. 

Scenario Full Replication process definition including master and 
replica servers and their connectivity (replication tree), 
report and event handling rules, properties of nodes, 
directories, sub-directories, databases and files that will be 
participating in the replication process. Each scenario is 
saved as an XML file.

Synchronization The process of producing an exact copy of the master 
server’s contents on remote replica servers.

Suspend 
replication

Temporarily cease delivering changes to the suspended 
replica. Changes are accumulated in a spool until replication 
is resumed so that re-synchronization is not required.

Resume 
replication

Begin transferring accumulated changes to a replica that was 
previously suspended. 
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Terms and Abbreviations
Abbreviations

Term Definition

CLI Command Line Interface. A non-GUI interactive shell enabling full 
control and monitoring of the replication process, including 
configuration of the replication scenarios.

MSSQL Microsoft SQL Server
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Chapter 2: About WANSync
 

This chapter describes WANSync and its modules.

WANSync
WANSync is a data protection solution that uses asynchronous real-time 
replication to provide cost-effective disaster recovery capabilities for Microsoft 
Exchange, Microsoft SQL Server, Oracle, Microsoft IIS webservers, file servers, 
and other applications on AIX, Solaris, Red Hat and both 32- and 64-bit 
Windows.

WANSync's asynchronous data replication over LAN or WAN of database and 
other files from a production server to one or more local or geographically 
distant replica servers offers rapid data recovery, integrated continuous data 
protection as a guard against data corruption, and completely non-disruptive 
automatic testing of your disaster recovery system, all in a system that sets the 
standard for ease of configuration and management.

When disaster strikes, and anything that puts a stop to your ability to do 
business is a disaster, it is critical that you respond effectively. Whether a flood 
or a blackout, or the more probable virus attack or user error, you must recovery 
quickly with minimal data loss or risk losing productivity, revenue, customers 
and opportunities, perhaps even the viability of your entire business.

WANSync data protection and data recovery software helps ensure that you are 
ready to respond.

WANSyncHA
WANSyncHA is a high availability solution based on asynchronous real-time 
replication and automated application switchover and switchback to provide 
cost-effective business continuity for Microsoft Exchange, Microsoft SQL Server, 
Oracle, Microsoft IIS webservers, file servers, and other applications on both 32- 
and 64-bit Windows servers.
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WANSyncCD
WANSyncHA offers push-button or fully automatic switchover of mission-critical 
application servers over a LAN or WAN, application-aware status monitoring, 
integrated continuous data protection as a guard against data corruption, and 
completely non-disruptive automatic testing of your disaster recovery system, 
all in a system that sets the standard for ease of configuration and management.

When disaster strikes, whether in the form of a hurricane, a blackout, or far 
more likely, a virus attack or software or user error, your ability to respond well 
to the crisis can make the difference between a bright future and the end of your 
business. At the very least, you are likely to incur significant costs in lost 
business and, perhaps more importantly, lost confidence by your customers, 
investors, and other stakeholders. Business continuity is not just about 
insurance. It is about maintaining your competitive edge. WANSyncHA is 
designed to give you that edge.

WANSyncCD
WANSyncCD is a highly versatile content distribution, delivery and consolidation 
solution for the distributed enterprise based on asynchronous real-time or 
scheduled software replication of files over a WAN.

WANSyncCD may be used to deliver, synchronize and consolidate corporate 
information repositories among multiple locations and branch offices around the 
globe. With WANSyncCD, employees and representatives in the field will always 
have the right information at the right time. 

WANSyncCD is also a powerful content delivery and web publishing solution that 
can serve your external customers through portals and web sites with any kind 
of information that is stored in files, from music to movies to documents to news.

Historically, the enterprise-class technology infrastructure needed to reliably 
distribute and manage information across a highly distributed environment has 
been tremendously expensive. The playing field has changed with CA XOsoft's 
WANSyncCD. Our content distribution software is simple, highly flexible, and 
very cost-effective content delivery, content consolidation, content publishing, 
and website publishing. 

Your company is living and competing in a connected world. WANSyncCD helps 
you make the connection.

Limitations
One-way replication only is permitted and the replica database must be offline. 
Bidirectional replication is not supported. Cross replication with different data 
sets is however supported. A server running WANSync can act as a master 
and/or replica for an unlimited number of scenarios so long as each data set only 
has a single master server, i.e., one way replicationWANSync.
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WANSync Server and Database Solutions
WANSync Server and Database Solutions
See the CA XOsoft website, www.caxosoft.com, for an up-to-date list of 
supported platforms and applications.

Software Modules
WANSync includes the following software modules:

XOsoft Engine. WANSync’s service - runs on each server involved in the 
scenario

WANSync Manager. Management GUI - used to manage and configure 
WANSyncHA

WANSync CLI. Provides a command-line alternative to the WANSync 
Manager for all platforms supported by WANSync

XOFS. Filter file system driver - installed together with the engine and 
loaded on the master automatically

XOsoft Engine

The XOsoft Engine is the executable service/daemon that lies at the heart of the 
system. It is installed on every server participating in the replication process, 
and must be running before any scenario can begin. Each engine supports both 
a master (source) and replica (target) functionality for both disaster recovery 
and high availability scenarios. It may participate in multiple scenarios and serve 
in a different role in each scenario.

WANSync Manager

WANSync Manager is a GUI application that manages all replication services 
(definition, configuration, monitoring and running) of the replication servers. 
Offline operation is mainly the definition of replication scenarios. Once a 
replication scenario is sent to the participating servers, the Manager also 
provides the means for online control (running, synchronizing, etc.) and 
monitoring (i.e. scenario status, log files, etc.). The WANSync Manager can be 
operated from any PC with connections to WANSync servers. It can manage all 
WANSync participating servers, regardless of the operating systems on which 
they are running.

The Manager connects as a TCP client only to the master defined in the 
replication scenario. Once a replication process is running, the Manager shows 
runtime statistics and events. In general it is no longer required for the process 
to continue.
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WANSync Features
WANSync CLI

The Command Line Interface (CLI) is offered as an alternative for those users 
who prefer to manage the replication process from the command line instead of 
from a GUI interface. This CLI is an interactive shell enabling full control, 
including configuring a replication scenario and controlling and monitoring the 
replication process. Note that the WANSync CLI does not support HA-related 
commands at this time.

The CLI can run in interactive mode like a UNIX shell, in which case it displays a 
prompt; in non-interactive mode it executes commands taken from the 
command line or standard input.

For more details, see Using the Command Line Interface (CLI).

XOFS

The XOFS is a proprietary file system filter driver. The driver captures all the file 
events. The WANSync engine manages the XOFS driver.

WANSync Features
The following table lists the features that are built into WANSync:

Feature Description
Replication Maintains replicas of files and databases by means of 

real-time capture of changes on a master server and 
immediate transfer to its replica servers.

Asynchronous 
replication

WANSync performs real-time capture of all changes to 
the file system. These changes, accumulated on the 
master’s spool directory, are transferred to the 
replica site asynchronously with minimal impact on 
either server. 

Multiple configuration Provides great flexibility in configuring replication 
scenarios between centrally managed multiple sites 
(one-to-one or one-to-many).

Single-port server All networking activity is carried out using a single 
port. This includes: data replication, WANSync 
configuration, multiple scenarios support.

Data integrity 
preservation

Data integrity is preserved at all times during 
replication. This is important for transactional 
systems such as databases and application servers.
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WANSync Features
WAN optimization Efficiently handles low bandwidth connections and 
latency. Automatically recovers from network 
failures. Can limit bandwidth requirements. 

Ability to suspend 
replication

Replication to a specific replica may be temporarily 
suspended to allow maintenance or other activity 
without the need to perform a full resynchronization 
afterward.

Non-intrusiveness WANSync does not require stopping applications or 
rebooting servers during installation (see Installing 
WANSync on Microsoft (MS) Windows), or activation. 
It attaches to always-open files and starts replicating 
without halting applications. 

Advanced scheduling Flexible scheduling capabilities. Synchronization can 
be scheduled for selected days of the week, and for 
specific hours or periods (e.g., every 9 hours), as well 
as the possibility of excluding specific dates. 

Synchronization The process of producing a current copy of the 
configured directories and files of a master on replica 
servers.

Block synchronization Very efficient binary difference algorithm that 
transfers only changes. (see Synchronization Modes 
for the full range of synchronization modes).

Synchronization with 
replication 

Can replicate and synchronize simultaneously. User 
does not need to halt updates on the master. 

Automatic In case of network or other failure.

Reporting differences Checks differences between master and Replicas 
without actually running the synchronization process. 

Recovery Recovers lost or corrupted master data from any 
replica by activating a synchronization process in the 
reverse direction. 

Rewinding data Allows repairing a corrupted file on a replica before 
starting recovery. This is accomplished by rewinding 
it back in time as if it were a tape, to a point before 
corruption had occurred.

Reporting

Events handling All events are reported in real-time to the WANSync 
Manager and can be integrated into the OS event 
logging system. They can be automatically sent by 
email to a configured address, and they can also 
activate a notification script.
Detailed real-time statistics are provided during 
synchronization and replication.

Live statistics reports Statistical reports are provided during replication as 
well as on synchronization completion.

Feature Description
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WANSync Features
Performance counters WANSync adds several performance counters to the 
standard MS-Windows set. These can be monitored in 
the MS-Windows Performance Counters window.

Switchover

Status monitoring Automatically monitors status of production server 
and applications.

Automated switchover Fully automated switchover of users and clients to a 
secondary server at the push of a button (or triggered 
automatically).

Application-aware Tailored versions for Exchange, SQL, Oracle, and file 
server ensure proper client switchover.

Multiple switchover 
methods

Supports Redirect DNS, Move IP, hostname switch, 
identify network traffic direction script, and 
user-defined redirection methods.

Remote installation 
wizard

Remote installation, uninstallation and upgrades for 
WANSync will be facilitated by a remote installation 
wizard. You will be able to deploy, uninstall or 
upgrade the WANSync service (XOsoft Engine) on any 
number of servers in one step. Requires the .NET 
framework v2 on the machine you are running the 
wizard on, each server does NOT require .NET 
framework v2 but does require that WMI be active. 
The default since Windows 2000 SP4 is for WMI to be 
active.

New scenario wizard The new scenario wizard will completely walk the 
user through entire scenario creation and 
configuration process. Once complete the wizard can, 
optionally, run the scenario. 

Automatic 
configuration of replica 
Exchange installation

The new scenario wizard will have the ability to 
automatically configure the storage groups and stores 
on your target Exchange replica servers. A default 
install of Exchange Server (at the same version and 
service pack level) on the replica is all that’s 
required. Routing and connectors should still be 
configured manually, if needed. You should also 
ensure that your replica server has the same drive 
letters as the master server, the underlying hardware 
is not important, only the drive letters. Supported 
only in HA scenarios.

Feature Description
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WANSync Features
Automatic 
configuration of replica 
IIS installation

The new scenario wizard can synchronize IIS 
metabase settings automatically to the replica server. 
Settings can be synchronized at the server level or 
just specific sites, as needed. Settings not stored in 
the metabase require manual configuration. Only 
supported for HA scenarios. This metabase 
synchronization functionality is also available via a 
command line tool (ws_iis2iis.exe).

Replication mode: 
Assessment Mode

Replication mode can be set to Assessment Mode 
allowing accurate bandwidth usage and compression 
ratio benchmarking, without actually replicating 
data. No replication will occur but statistics will be 
gathered. A report will be provided after the specific 
report interval is reached.

Expanded status 
information when 
viewing multiple 
scenarios 
simultaneously

Easy viewing of scenario status and type from the 
Scenarios pane. In one pane you will be able to 
simultaneously see the following information for all 
scenarios, via added columns. Rights, Errors, Status, 
Extended Status, Product, Server type, Mode, and 
Started by. You can customize what columns will be 
shown or hidden in the scenarios pane. 

Improved GUI view for 
one-to-one scenarios

GUI view for scenarios with only one replica has been 
modified to be more graphical and visually 
descriptive. Which server is active, replication 
direction and spool usage is graphically displayed. 
Users can switch between classic and graphical views 
by clicking a button in the top right of the pane. 

Ability to apply 
changes to multiple 
scenarios 
simultaneously

Common scenario setting changes can be applied to 
multiple scenarios at once. Scenarios must be stopped 
to apply changes. This functionality is accessed by 
right clicking on the property in question and choosing 
Propagate Value. A good example would be to use this 
to change the e-mail notification address for multiple 
scenarios at once. 

Exchange Storage 
Groups can be 
excluded in High 
Availability scenarios

In the past it was required to replicate and monitor 
all Exchange Storage Groups if using a High 
Availability scenario. Now you are given the option to 
exclude specific Storage Groups from replication and 
monitoring. This can be done during the 
autodiscovery process. 

Scenarios can be 
stopped and started via 
a right click context 
menu

Rather than selecting the scenario and clicking the 
start button it’s now possible to simply right click on 
the scenario (in the scenarios pane) and select an 
option to run the scenario.

Feature Description
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WANSync Features
Greater scheduling 
granularity for 
scheduled tasks 

This applies to Assured Recovery, Suspend and 
Scheduled Replication. In the past you were limited to 
choosing times that were on the hour and in a 
minimum of 1 hour increments. With this version tasks 
can be scheduled to start at any specified time 
and/or at any interval in minutes. 

Feature Description
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Chapter 3: The WANSync Solution
 

The following sections cover the scope of the WANSync solution, and the various 
component functions taking part in the process: what they can do, and how they 
do it.

WANSync Process Flow
The Replication Process can replicate data between any set of servers running 
the WANSync replication service. Replication can be performed over a WAN 
(wide area network), the Internet, or over a LAN (local area network), so long 
as all participating servers have the required software installed, and TCP 
connections between them.

The process requires first setting up a valid scenario, then beginning the 
replication process. Once the replication process has commenced, then at any 
given time, the data may be retrieved. The WANSync Manager assists in the 
process, and also in monitoring both the replication and the retrieval of data.
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WANSync Process Flow
Disaster recovery scenario

High availability scenario
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How Synchronization Works
How Synchronization Works
Synchronization of files is the process of making the set of files to be protected 
identical on the master and replica servers. It is usually necessary to 
synchronize the master and replica as the initial step of a replication scenario.

Important! We strongly recommend running the initial synchronization during 
off-peak hours.

Synchronization Modes

In order to properly synchronize the master and the Replica, we must first 
perform a comparison of their two file structures in order to determine what 
content (files and folders) on the master is missing or different from that on the 
Replica. WANSync supports several different synchronization modes, each with 
a different comparison algorithm and method of operation.

Synchronization Filter

The Synchronization window includes a check box that can be toggled on or off:

Content distribution scenario
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How Synchronization Works
Automatic Synchronization

When on, the automatic synchronization property causes the master and replica 
servers to be automatically resynchronized in the event one of the following 
occurs:

If the replica is rebooted, WANSync resynchronizes the master and the 
replica automatically after reboot

If the master is rebooted, WANSync resynchronizes the master and the 
replica automatically after reboot

If the master spool overflows because of network failure, WANSync 
resynchronizes the servers automatically upon resumption of the connection

Simultaneous Synchronization and Replication

WANSync allows simultaneous synchronization and replication. This means that 
servers can be synchronized while files are in active use and being updated; all 
changes that occur while the initial synchronization is performed are replicated 
without any need for administrative intervention.

Important! When modifications to master server files are occurring during 
synchronization, do not use the Simple Copy Synchronization method.

Reporting Synchronization Differences

The data sets on the master and replica servers may be checked without actually 
performing a full synchronization through the Difference Report command.

Synchronization 
Filter

Explanation Recommended Use

Ignore same 
size/time files

Skips comparison of files 
with the same path, name, 
size and modification time. 
This assumes that the files 
are identical.

Only use this option in 
conjunction with either the 
File Synchronization mode 
or the Block 
Synchronization mode.

When you are absolutely 
sure that files of this type 
are indeed identical. This 
option is not appropriate 
for database files for such 
applications as Exchange, 
SQL, or Oracle.

This option can reduce the 
overall synchronization 
time dramatically. 
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How Replication Works
How Replication Works
The replication mechanism maintains identical copies of files and databases by 
real-time capture of byte-level changes in files on the master server using the 
WANSync Engine. The captured changes are asynchronously transmitted to the 
replica servers, using a file-system filter-driver. The replication process does not 
interfere with write operations.

To accommodate real-time replication of all types of files, WANSync supports the 
following replication modes:

How Recovery Works

When master data is lost or corrupted for any reason, WANSync can recover the 
data from any of the Replicas in the scenario. 

The Restore Data option basically activates a synchronization process in the 
reverse direction: from replica to master. 

When recovery is initiated, WANSync Manager builds a temporary tree, 
containing a single branch. In this tree, the replica becomes the source of data 
and the original master becomes the target (i.e., the terminating replica).

Once the synchronization process completes, the WANSync Manager reverts to 
the original replication scenario, and continues working.

Replication Mode When Used

Online mode Replicates all changes of files, even if files are always 
open (as is the case for most database and mail 
servers). This mode maintains the order of file system 
operations. In this mode, the engine records all I/O 
operations related to the root directories in journal files. 
The journal files are then sent to the Replicas where the 
operations that were recorded in the journal are 
replayed on the replicated files.

Scheduled mode Synchronization of servers takes place at fixed times. 

There is no online replication in this mode, however, 
online changes made during synchronization are 
replicated.

Assessment mode Replication mode can be set to Assessment Mode 
allowing accurate bandwidth usage and compression 
ratio benchmarking, without actually replicating data. 
No replication occurs but statistics are gathered. A 
report is provided after the specific report interval is 
reached.
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How High Availability (HA) Works
Important! All file system activity must be halted on the master host until the 
recovery process finishes.

How Replication Suspension Works

At times it may be necessary to suspend updates on a replica machine in order 
to perform system maintenance or some other form of processing that does not 
modify the replicated data there. It is not desirable to stop replication since this 
requires a full resynchronization afterward.

The replication suspension feature of WANSync makes this possible. Replication 
may be suspended either manually or on a scheduled basis. During the period 
of the suspension all changes are spooled on the master or on the replica located 
upstream of the suspended Replica. In other words, changes continue to be 
recorded for update on the suspended replica, but are not actually transferred 
until replication is resumed. Once replication is resumed, the accumulated 
changes are transferred and applied without any need to perform a full 
resynchronization of the data.

How Data Rewind Works

Because replication continuously updates source data to another machine, a 
replica always holds the same data as in the master. In the case of data 
corruption, recovering files from the replica will not help, since chances are high 
that data in the replica is also corrupted.

Data Rewind is a new technology that allows repairing a corrupted file by 
rewinding it back in time as if it were a tape.

Data Rewind can be compared to the Undo feature of Microsoft Office where user 
actions can be cancelled, thus bringing the file to a previous state in time. Data 
Rewind is based on rewind journals that store I/O operation information that 
result in modified files. Using the rewind journal, it is possible to undo I/O 
operations, thus rewinding the file to a previous point in time, supposedly to a 
valid, non-corrupted state.

How High Availability (HA) Works
WANSyncHA monitors all critical events, including global server failure and all 
database service failures, and either automatically or on command, initiates 
High Availability switchover. 

Should the master server become unavailable, service can be switched over 
automatically to a remote site (Replica). The switchover that is transparent to 
the user includes immediate startup of a synchronized standby database, and 
redirecting all users to it in minimum time, without any need to reconfigure 
either clients or the network.
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How High Availability (HA) Works
Depending on the requirements of the application being protected, 
redirection can include:

Move IP (if the standby site is implemented within the same network 
segment)

Redirect DNS, when the remote standby site is located on a different IP 
network (cross-network switchover)

Switching the application hostname/NetBIOS name

Identify Network Traffic Direction scripts, required to fully support custom, 
or customized, redirection methods. Custom scripts or batch files are used 
to identify the active server. This script determines if the forward or 
backward scenario is run when the scenario is started. The script runs on 
both master and replica: the one that returns zero is active. If both return 
zero, a conflict is reported.

Triggering custom scripts to add or replace the built-in redirection methods
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How High Availability (HA) Works
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Chapter 4: Assured Recovery
 

This chapter describes the use of Assured Recovery automatic replica database 
testing for users with the appropriate license. 

This chapter covers WANSync/WANSyncHA for Exchange, SQL, and Oracle. 
Throughout this chapter the term WANSync refers to all products, unless 
otherwise specified.

About Assured Recovery
You’ve already secured your business’ most critical assets by implementing a 
replication solution to protect your data and applications – but are you certain 
that you’ll be able to flawlessly switchover when the time arrives? If it was worth 
your time and the resources to your organization to implement a disaster 
recovery solution, isn’t it sensible to test to ensure that it works? It’s critical, in 
fact. No disaster recovery solution is complete without a test. 

An effective test of data that has been replicated to a backup server requires 
ensuring that the application that uses it can successfully start, read, and write 
the data on which it depends. This kind of test modifies the database and then 
requires a time-consuming resynchronization with the production copy. This 
process ties up bandwidth and system resources and leaves the production 
system vulnerable in the interim. 

Assured Recovery offers a solution. It enables a full transparent test of the 
recoverability of your data on a replica system by actually starting up application 
services and performing whatever operations are required to verify the integrity 
of the data, including updates to the database, without any need to perform an 
expensive resynchronization or to leave the production system vulnerable during 
the test.
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About Assured Recovery
Assured Recovery testing is tailored to the mission-critical applications that are 
being protected including Exchange, SQL, Oracle, and File Servers while 
integrating the state-of-the-art Continuous Data Protection (CDP) technology. In 
addition, the test can be fully automated and performed on a scheduled basis as 
often as makes sense – once a week, once a day, even once an hour. Upon 
completion, appropriate staff can be alerted with the status of the test, and 
additional actions can be triggered on success, for example, running a snapshot 
or a backup of the data -- data that has been verified as fully consistent.

Note: Assured Recovery is available for WANSync and WANSyncHA scenarios 
for Exchange, SQL, Oracle, and IIS running on Windows Server 2000 or 2003. 
WANSync version 3.71, build 30 or later, is required. File Server Assured 
Recovery is also available and by default takes VSS snapshots on the replica. 
Since there is no application per se, testing of the data with File Server scenarios 
requires additional custom scripts.

Rewind Technology

The difficulty with validating a database on a passive standby replica by starting 
the database application and running transactions against it is that most 
databases modify the data even when they simply start. Once this occurs, the 
replica database is out of sync with that on the production system and a 
resynchronization is required.

Assured Recovery builds on the unique rewind technology built into both 
WANSync to resolve this problem. When the Replica Integrity Test function is 
invoked, WANSync suspends application of the replicated changes on the 
selected replica server by accumulating changes on the selected replica server 
in the replica spool, ready to be replayed when testing is complete. Once 
application of changes on the replica has been paused, a process is started on 
the selected replica to record all changes that occur to the database there in a 
rewind journal. Once testing is complete, all the changes that occurred during 
the test are backed out; for example, the MS Word undo function, so that the 
database is restored to precisely its state when application of new changes was 
suspended. At that point, accumulated changes on the replica server are 
applied.

License Registration

If WANSync has been registered previously, update it with the new registration 
license for Assured Recovery.

To update the registration:

1. Start WANSync Manager.

2. Select Help > Register. A dialogue box appears:
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Set Up Assured Recovery Replica Testing
3. Enter the new registration key. 

4. Select OK.

5. Close WANSync Manager and start it again in order for Assured Recovery to 
take effect.

Set Up Assured Recovery Replica Testing
The automatic replica testing provided by Assured Recovery must be enabled 
when the scenario using it is created. For this reason, if you wish to perform 
replica testing within a disaster recovery or high availability scenario that is 
currently running, it is necessary to create a new scenario with the same 
configuration and with replica integrity testing for Assured Recovery turned on.
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Configure Assured Recovery Testing on the Replica Server
Set up the scenario as you would normally, either duplicating the settings in the 
scenario you plan to replace, or following the instructions in the appropriate 
operations guide.

Configure Assured Recovery Testing on the Replica Server
Assured Recovery testing is configured in Scheduled Tasks in the Properties 
panel associated with the replica server on which the application data is 
validated.
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Configure Assured Recovery Testing on the Replica Server
Note that you can define only one scheduled task per scenario. If you attempt 
to configure replica testing and already have a scheduled Suspend operation 
configured, the following message appears: Only one scheduled task per 
scenario can be set. Suspend for this host is already switched on. Do you want 
to turn this option off now? Click Yes or No.

If you have multiple replica servers in the scenario and have already configured 
replica testing for one of the others, the following message appears: Only one 
scheduled task per scenario can be set. Replica integrity testing for Assured 
Recovery for host replica is already switched on. Do you want to turn this option 
off now? Click Yes or No.

Pressing Yes in either case switches off the previously configured scheduled task.

To configure the schedule verification, set replica integrity testing for Assured 
Recovery to On.

The default behavior is to verify that database services can be successfully 
started and that databases mount properly. If this is sufficient, all that is 
required is to select the Schedule field and to define the schedule on which 
verification should occur. Scheduling is configured using the standard WANSync 
scheduler.
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Configure Assured Recovery Testing on the Replica Server
You can customize the default behavior as described in the next section. In 
addition, Assured Recovery supports non-disruptive manual testing (see Test 
Assured Recovery Manually in an Exchange Environment).

Customize Assured Recovery Testing

For supported applications, replica testing is fully automated, including starting 
and stopping application services. Just as in the case of high availability 
switchover and switchback, if the application is configured in a non-standard 
way, it may be necessary to customize how database services are started and 
stopped. In addition, you may want to add customized tests or to specify 
additional actions to take after the replica has been checked successfully. 

Options to customize the behavior of Assured Recovery testing are presented in 
the order in which they occur during operation, from starting application services 
through operations to perform after a successful test before and after the 
application is stopped on the replica server.

Start DB

In this section, you can specify a script to augment or replace the standard steps 
to start the application services. To replace the standard steps, set Automatic to 
Off and specify the full pathname of the script to be executed in their place in 
User defined script. If you specify a script and leave Automatic set to On, the 
script is executed following the standard steps.

Replica DB Testing

The standard test for application integrity on the replica is to verify that all 
application services have started properly and that all databases or information 
stores have mounted successfully and are in a valid state. You can also 
customize the actions performed during database validation by specifying in 
User defined script the full pathname of a script to be run following the standard 
test (or in place of it if Automatic is set to Off).

Actions on Successful Test (DB Online)

After the replica is successfully tested, the application data is in a known, valid 
state, and you may want to make use of this fact, for example, to ensure that a 
backup is performed at this point on validated data. If the action you want to 
take requires that the application is running and the databases or information 
stores mounted, then it should be registered through a script here, in this step, 
by specifying the full pathname of a script in User defined script. This section has 
no default actions.
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Configure Assured Recovery Testing on the Replica Server
Stop DB

In this section, you can specify a script to augment or replace the standard steps 
to stop the application services. To replace the standard steps, set Automatic to 
Off and specify the full pathname of the script to be executed in their place in 
User defined script. If you specify a script and leave Automatic set to On, the 
script is executed preceding the standard steps.

Actions on Successful Test (DB Offline)

As noted in Actions on Successful Test (DB Online) above, at this stage the 
application data is in a known, valid state and you may want to copy it or perform 
a backup or snapshot. If the action does not require the application to be 
running, it should be registered through a script here, in this step, by specifying 
the full pathname of a script in user-defined script. On Windows Server 2003 
only, you can generate a snapshot automatically using Microsoft’s Volume 
Shadow Copy Service (VSS) by changing the Create Shadow Copy (VSS) field to 
On (see The vss_util).

By default, WANSync creates ten snapshots and then begins replacing the oldest 
snapshots with newer ones. You can change the setting for the number of 
snapshots created using the Number of Snapshots Set To Keep property. You 
can also specify the volume on which snapshots are stored as well as limiting the 
maximum total storage used by snapshots (see The vss_util).

Note: By default, File Server Assured Recovery takes VSS snapshots on the 
replica. Since there is no application per se, testing of the data with File Server 
scenarios requires additional custom scripts.

Test Assured Recovery Manually in an Exchange Environment

When testing Assured Recovery manually in an Exchange environment it's 
important that user accounts no longer reference the replica server after testing. 
If they do, WANSync reports errors. Assured Recovery rewinds the databases 
back to the pre-test state. All other manual changes must be backed out 
(manually) after testing. An easy and effective way to test Exchange manually 
while ensuring that this issue does not occur is outlined below.

1. Before manual testing, create one or more test accounts with mailboxes on 
the production Exchange server. Log in using these accounts and verify that 
they work. Make sure new mail is sent/received so you can verify that 
replication is occurring during your test.

Important! Test accounts are required because all mail sent or received to 
these accounts during testing are lost since we rewind the replica databases 
to the pre-test state after testing.

2. Close any Outlook clients logged in with your test account(s).

3. Switchover each test account individually by running the below command on 
the replica server (the executable is located in the WANSync install folder):

Ws_ex2ex.exe -n -u -s master_name -t replica_name -f "User Account Display Name" -p
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Configure Assured Recovery Testing on the Replica Server
4. Start Assured Recovery manual testing (use the Manual DB testing 
checkbox). Wait until the following message is displayed: Replica is ready for 
Manual DB Testing.

5. On the test client, go to Control Panel > Mail. If the master server is listed, 
select Check Name again so the client recognizes that this test account is 
now on the replica exchange server.

6. Open Outlook so you can send and receive mail on the replica server. Please 
remember that all mail received by the test accounts during testing are lost 
after testing completes. You can also test other functions such as OWA at 
this point.

7. Once you are satisfied that your replica Exchange server is functional, close 
Outlook for the test account(s) and run the below command. This fails 
individual users back to the master server:

Ws_ex2ex.exe -n -u -s replica_name -t master_name -f "User Account Display Name" -p

8. Stop Assured Recovery. Your replica databases rewind back to the pre-test 
state and resume online replication. 

9. On the test client, go to Control Panel > Mail to verify that the master server 
is now listed. If the master server is still listed select Check Name again so 
the client recognizes that this test account is now on the master exchange 
server. Try to open Outlook again (if this fails wait five minutes and try 
again).

The vss_util

VSS snapshots created during database verification do not show up in the 
normal snapshot manager. To manage these snapshots, the vss_util.exe 
command-line utility is provided with WANSync in the installation directory.

The utility vss_util.exe is an interactive shell that provides a simple interface for 
managing the volume shadow copies (VSS snapshots) on your machine. The 
interface allows you to perform the following functions:

Query a shadow copy

Expose a shadow copy locally

Delete a shadow copy

Manipulate shadow copy storage association

All commands require the snapshot ID. The snapshot ID is reported in the event 
window of the WANSync Manager and can be displayed using the query_all 
command (see Shadow Copy Query).
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Configure Assured Recovery Testing on the Replica Server
List Commands
You can display a list of all commands available in vss_util using -h.
The -h command provides command-specific use.

Shadow Copy Query
You can display the properties of a given shadow copy using the query command.
Syntax: query <snapshot ID>

Example: query {2b270bc1-ee95-4116-b54d-d341363f70f7}

To display all snapshots with their IDs use the query_all or query_all -d 
commands (query_all -d provides significantly more detailed information).
Syntax: query_all | query_all -d

Expose a Shadow Copy Locally

A shadow copy can be exposed as a local read-only volume that may be mounted 
on a drive letter or at a mount point. It remains exposed through subsequent 
boots. Dismounting an exposed snapshot releases it without losing the snapshot 
itself.

Exposed as a drive letter

Syntax: expsv <snapshot ID> <drive-letter>

Example: expsv {2b270bc1-ee95-4116-b54d-d341363f70f7} z:

Note: The drive letter must be unused.
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Configure Assured Recovery Testing on the Replica Server
Exposed as a mount point

Syntax: expsd <snapshot ID> <directory>

Example: expsd {2b270bc1-ee95-4116-b54d-d341363f70f7} c:\scs\last

Note: The directory must be empty.

Dismount locally exposed snapshot

To release an exposed snapshot without losing the snapshot itself, use the 
unmnt command. The snapshot is still exposed but it does not use a mount 
point.
Syntax: unmnt <snapshot ID> 

Example: unmnt {2b270bc1-ee95-4116-b54d-d341363f70f7} 

You can remount the dismounted snapshot to an unused drive letter using the 
mnt command.
Syntax: mnt <snapshot ID> <drive-letter>

Example: mnt {2b270bc1-ee95-4116-b54d-d341363f70f7} z:

Shadow Copy Delete
You can delete shadow copies individually using the del command.
Syntax: del <snapshot ID>

Example: del {2b270bc1-ee95-4116-b54d-d341363f70f7}

Additional syntax options include:

delx <SnapshotSetID> Deletes a snapshot-set

del_all   [-e] Deletes all shadow copies (snapshots) on the system 
[-e] all except client-accessible (exposed) snapshots

Example: del {2b270bc1-ee95-4116-b54d-d341363f70f7}
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Assured Recovery in Non-Scheduled Mode
Manipulate Shadow Copy Storage Association

The storage command gathers a group of options that handle shadow copy 
storage (by default, snapshots on volume X are stored on volume X).
storage [-c | -d | -q | -u] [Volume] [StorageVolume] [StorageMaxSize]

Important! Please note that you can use VSS only on Windows Server 2003 
(not earlier versions).

Assured Recovery in Non-Scheduled Mode
You can test the database on a replica manually by selecting Tools > Replica 
Integrity Test (or by pressing the Start/Stop Replica Integrity Testing for 
Assured Recovery button on the toolbar). 

The resulting window displays the settings that are used for the test – they are 
taken from those you have set in the replica properties tab. If you press the OK 
button now, the configured tests are performed in the same way as on a 
scheduled basis.

[-c] Volume 
StorageVolume 

[StorageMaxSize]

Creates shadow storage association

[-d] Volume Deletes shadow storage association

[-q] Queries all shadow storage associations

[-u] StorageMaxSize Updates shadow storage max size

Volume Specifies the shadow copied volume

StorageVolume Specifies the volume that is used as a storage

StorageMaxSize Specifies the max storage size in Mega bytes
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Assured Recovery in Non-Scheduled Mode
At this point, you also have the option of performing full manual testing by 
selecting the Manual DB testing check box. In this mode, the Assured Recovery 
product starts application services on the replica and informs you when the 
server is ready for testing. You can then perform any testing directly on the 
replica server. When you are done, you must press the Start/Stop Replica 
Integrity Testing for Assured Recovery button again to resume replication.

Important! If you do not press the Start/Stop Replica Integrity Testing for 
Assured Recovery button a second time, changes will continue to spool up on the 
replica server. Eventually, the spool on the replica server overflows and the 
scenario is stopped.
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Assured Recovery in Non-Scheduled Mode
When the Manual DB testing checkbox is selected, the window changes to reflect 
the subset of actions that are performed automatically:

Press OK, then wait for the message Replica replica-name is ready for manual 
DB testing. After this message appears, you can perform tests directly on the 
replica server. After you are done, press the Start/Stop Replica Integrity Testing 
for Assured Recovery button again. Wait for the message Finished DB integrity 
testing.
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Chapter 5: Creating Replication 
Scenarios
 

WANSync is a powerful, easy-to-use product for creating and maintaining full 
online backups of your business or other important data. WANSync monitors 
your file system online, intercepts and copies all additions or changes to it, and 
transmits this information online to your backup servers.

User-Defined Scenarios
WANSync creates and maintains backups in the context of user-defined 
scenarios. A scenario defines a replication tree that defines the flow of 
information from the master server to any number of designated Replicas, and 
establishes the properties of the replication and, if applicable, switchover 
processes.

You can configure, add or remove servers from a scenario and select or modify 
directories. This enables easy, complete control of the replication process over 
any network, large or small.

The user-friendly GUI enables you to rapidly learn and control any number of 
scenarios. Follow the instructions in this chapter for an easy start.

Note: In order for the replication process to succeed, verify that the user under 
which the WANSync Engine is running has permissions for each replication root 
directory, and on all participating hosts.

Install WANSync Manager
Install WANSync Manager and the Remote Installation Wizard onto the machine 
from which the WANSyncHA scenario will be configured. The location of the 
Manager is not critical so long as it is accessible in the event of a disaster. The 
Manager is frequently installed on a server room or an administrator's 
workstation.
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Install the XOsoft Engine Service
Important! If the Manager is installed directly on either the master or replica 
servers, ensure that the XOsoft Engine is also installed.

If you intend to use the XOsoft Remote Installer (recommended), the machine 
on which you are running the remote installer should have the .Net framework 
2.0 installed. The framework is required only on the machine running the remote 
installer wizard (GUI); the target servers do not have this requirement. 

After the scenario is run it is cached on your master and replica servers. Once 
cached, you can download it to any installed WANSync Manager by selecting 
Download from the File menu (then enter the name of your master or replica 
server).

Install the XOsoft Engine Service
The following subsections describe how to install the XOsoft Engine service to 
the servers involved your WANSync scenarios.
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Install the XOsoft Engine Service
Remote Installation Wizard

You can use the Remote Installation Wizard to deploy the XOsoft Engine to any 
number of servers, or cluster nodes, in one step. Alternatively, you can install 
the XOsoft Engine manually by running setup.exe directly on each server.

Installation location - ensure that this path is correct and contains a valid 
WANSync setup package.
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Install the XOsoft Engine Service
Hosts selection - select the servers (or cluster) nodes to which you want 
to deploy the XOsoft Engine (you can add servers manually from the Host 
Name/IP Address box).
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Install the XOsoft Engine Service
User credentials - the user account that is used to install the XOsoft Engine 
on each target server (ensure that this account is a local Administrator on 
all target machines).
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Install the XOsoft Engine Service
Preinstall verification - click Next after all servers have reported success.

Install settings - select This Account and enter your WANSync service 
account domain\username and password. Disaster Recovery scenarios can 
use Local System; High Availability scenarios may require higher levels of 
permissions (see the appropriate operations guide for details).

Important! Do not proceed without first setting the correct service account.
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Install the XOsoft Engine Service
Ready to Install - confirm that all desired servers are listed and then click 
the Install button.

Installing - you can monitor the installation process from this screen.
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WANSync Manager Screen
Report - in this last step you can view the full installation report and, 
optionally, save a copy (the XOsoft Engine now is installed on all selected 
servers or cluster nodes).

WANSync Manager Screen
When the application is first run, the WANSync screen is called up. Unless a 
scenario exists, most of the user areas are blank.

Note: The Switchover tab in the window on the right is visible only with a High 
Availability (WANSyncHA) product license.
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WANSync Manager Screen
The screen is divided into several areas:

1. The application’s name (WANSync Manager <version#>); the menu line, 
and the toolbar appear on the screen’s top line.

2. Scenarios appear on the far left window pane.

3. The Replication Tree appears in the middle window pane.

4. The Framework window is the far right window pane.

5. The Events window is below the screen’s dividing line.

6. The bottommost line is the Status bar.

Note: The Framework window may show two or three tabs. The actual 
placement of the windows can vary because they can be moved and resized. 
Also, the windows, including the toolbar and status bar, can be made invisible 
according to the selections in the View menu.
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The New Scenario Wizard
The New Scenario Wizard
To use the new scenario wizard:

1. Open the WANSync Manager

2. Click the New icon on the toolbar (or type ctrl+N, or from the menu, select 
Scenario > New, or place the mouse cursor in the Scenario window and press 
the keyboard's Insert key, or right-click and select New).

Important! This section demonstrates configuration of a File Server 
disaster recovery scenario.  For more detailed instructions involving High 
Availability scenarios or tailored to specific applications, such as Exchange 
or SQL, please reference the appropriate operations guide.

3. Click Next to create a new scenario.
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The New Scenario Wizard
4. Select the Server Type, Product Type and Assured Recovery (if available).
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The New Scenario Wizard
5. Input the hostname or IP address of the master and replica servers.
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The New Scenario Wizard
6. Select the master data to be replicated.
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The New Scenario Wizard
7. At this point, you can modify scenario properties. Typically, the default 
settings are sufficient. For more details, please see the appropriate master 
and replica properties sections later in this guide.
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The New Scenario Wizard
8. Scenario creation is now complete. Any configuration issues detected by 
WANSync are displayed here.
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Create a Scenario Manually
9. Now you can run the scenario. Running the scenario starts the data 
synchronization process. Alternatively, you can click the Finish button to run 
the scenario later.

Create a Scenario Manually
This section demonstrates the configuration of a generic scenario. For more 
detailed instructions involving High Availability scenarios or scenarios tailored to 
specific applications such as Exchange or SQL, please see the appropriate 
operations guide.

To create the scenario:

1. Open the WANSync Manager.

2. Click the New icon on the toolbar (or type ctrl+N, or from the menu select 
Scenario > New, or place the mouse cursor in the Scenario window and press 
the keyboard's Insert key, or right-click and select New).

The New Scenario Wizard opens.
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Create a Scenario Manually
3. After clicking Next a list of available applications and scenario types are 
presented (the list of available applications depends on the licenses applied). 
Make your selections and then click Finish to create the scenario manually.

Note: If Assured Recovery (AR) is not licensed on a given machine, the 
Replica integrity testing for Assured Recovery box is grayed out. If you are 
licensed to use AR, check the box when creating a scenario (see License 
Registration). AR will also be grayed out if a File Server scenario is selected, 
this scenario type does not offer AR.
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Define the Master Server
Define the Master Server
To define the host computer:

1. Right-click on the Enter master host here text and select Rename. 
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Define the Replica Server
2. Type in the server name or IP address of the host. 

3. Press <enter> on your keyboard, or click anywhere outside of the text field. 
WANSync immediately attempts to locate the computer with that name. If it 
cannot be located, an error message appears: Cannot resolve host name. 
Try again, or ask your system administrator for assistance in locating the 
proper computer.

Note: You can enter an IP address instead of a hostname.

Define the Replica Server
Every scenario is created with an empty master and one empty Replica. To 
define the replica server, go to the Replication tree window, select the line 
reading: Enter replica host here and proceed as you did for the master server. 

Rename the Server

To rename the replica:

1. Right-click the name field. A pop-up menu appears. 

2. Select Rename.

Add Additional Replica Servers

To add additional replica servers:

1. Select a host (master or replica) under which you want to add a server. 
Right-click and select Insert host from the pop-up menu or select Edit > 
Insert host.
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Select Master Directories and Their Contents
2. A new replica server entry appears. Define it as you defined the master host, 
and set its properties.

Select Master Directories and Their Contents
This section explains how to select directories and files for replication. Note that 
for certain applications like Exchange, SQL, etc., you can use the WANSync 
autodiscovery feature may be used to select files automatically. See the 
appropriate sections below.

Important! Special limitations apply to mapped drives or UNC paths 
(\\server\share). These path types are not supported as a source for real-time 
replication. However, they can be the target for data replicated in real-time, in 
which case, they can even support ACL replication. If these path types are used 
as the source, you are limited to scheduled synchronization only and open files 
are not synchronized.

To select master directories and their contents:

1. Select the master server in the Replication Tree window.

2. In the Framework window, click the Directories tab at the bottom. The 
directory information appears in the window.

3. Double-click the master root directory named Directories. The Browse and 
select directories window appears. Alternatively, right-click anywhere in the 
window, and select Browse and select directories.

Note: Working with Browse and select directories is possible only if the 
WANSync Engine is installed and running on the host.
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Select Master Directories and Their Contents
Mark and Unmark Directories and Files

To mark and unmark a directory or file:

1. The Browse and select directories window has two areas. The left-hand area 
shows only directories (and sub-directories). The right-hand area shows 
both directories (and sub-directories), and files in those directories. The 
checkboxes are for you to mark or unmark. When marked, those directories 
or files are selected. Those not marked are ignored. 
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Filter Master Directories
2. In the window’s left-hand area, mark the directories that are to participate 
in the master’s replication scenario, by clicking on the relevant checkboxes. 
These are the master root directories. The checkbox is marked, and the 
directory name is bold.

3. If a root directory is a sub-directory, it remains bold and marked, and its 
parent directory is marked with a grayed checkmark.

4. All files and sub-directories belonging to the directory that is highlighted in 
the left-hand area are displayed in the right-hand area. 

5. You can unmark right-hand area sub-directories and specific files. They are 
then ignored.

6. If you unmark any of the right-hand area sub-directories and files, they are 
ignored, but the root directory is still marked. However, it is marked with a 
grayed checkmark.

7. Click OK, when you have finished choosing all your directories and files.

8. The directories selected now appear in the WANSync Manager’s Framework 
window under the master root directories column.

Edit Directory Names

To edit a directory name:

1. Select the directory and enter a new name using Windows conventions; 

2. Or, right-click and select Rename from the pop-up menu; 

3. Or, select Edit > Rename from the menu bar.

Remove Master Root Directories

To remove a master root directory:

Right-click a directory entry and select Remove directory from the pop-up menu, 
or select Edit > Remove directory.

Filter Master Directories
The filtering options do not mark (or unmark) items in the window. That has to 
be done manually. Instead they provide several key functions:
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Filter Master Directories
All, Include, and Exclude provide a visual interface for you to view items

Anything which is not visible (has been filtered out), whether it has 
previously been marked or not, is ignored as if it is unmarked

Note: Replication ignores any files that have been filtered out (Exclude).

WANSync filters use standard wildcards:

An asterisk (*) selects any number of characters/digits of all types

A question mark (?) selects any single character or numeric digit

A pound sign (#) selects any numeric digit

An ampersand (@) selects any single character

Entering other characters (one or many) selects for those specific characters

A given filter selection applies to all files in all directories in the scenario.

1. Double-click on any of the selected directories to re-open the Browse and 
select directories window.

2. Select the desired directories.

3. In the Figures below, the directories, subdirectories and files belonging to 
the object highlighted in the left-hand area are displayed in the right-hand 
area.

4. Choose the appropriate file filter (All files, Include files, Exclude files) and 
follow the directions in the following pages to select the desired files and 
subdirectories:

Click All files to select all files in the selected directories. This is the 
default. Instructions are as per Mark and Unmark Directories and Files.

Click Include files to include only the selected files or file-types. The 
filter text entry box is enabled. Enter the appropriate filtering characters 
(characters, strings, wildcards, file names or extensions, etc.). 
Instructions are as per Include Files.

Click Exclude files to exclude only the selected files or file-types and to 
include all others. The filter text entry box is enabled. Enter the 
appropriate filtering characters (characters, strings, wildcards, file 
names or extensions, etc.). Instructions are as per Exclude Files.

Note: Filtering is possible only if there is a TCP connection between the 
master server and the manager.

Include Files

When using Include files, only the files or file-types entered into the include text 
entry field are included in the replication scenario, and only if marked (checked). 
Manually unmarking a file overrides All files and Include files.
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Filter Master Directories
To include files:

1. Click the Include files radio button at the top of the Browse and select 
directories window. This enables the text entry field (the text entry box is 
enabled with an asterisk (*) wildcard).

2. In the previous example, *.bmp and *.txt were entered as the Include files 
parameters. Clicking the Apply button carries out the filtering. Here, the only 
files displayed on the right-hand side are those that have the BMP or TXT 
extensions.

You can enter more than one wildcard pattern into the text entry field. Use 
a blank space to separate the names. Do NOT use a comma or semi-colon, 
etc. If a file name includes blanks, enclose the complete file name between 
quotation marks ("").
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Filter Master Directories
Exclude Files

To exclude files:

1. Select the Exclude files radio button and enter a value; for example, exclude 
all files ending in the extensions *.xls , *.doc , *.ppt. Separate the 
extensions using a comma or a space: make sure there is a space between 
the file extension and the separator (e.g., *.xls<space><comma>).

2. Marking the root directory on the left side also marks all the right side 
sub-directories and the files matching the exclude criteria.

3. You can unmark any number of individual files or sub-directories by 
removing the checkmark next to their names. When a file is unmarked, the 
checkmark next to its path is grayed-out.
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Autodiscover Database Files for all Databases
Autodiscover Database Files for all Databases
To facilitate easy directory selection for standard databases supported by 
WANSync, database directories and files are identified in the scenario host by 
using database APIs. Thus, WANSync displays the structure of the database and 
makes the appropriate selections, which may then be easily modified if 
necessary.

The WANSync auto-discovery function automatically discovers all database 
objects, related files and directories on your database or mail server — whether 
local or on a network. This function is currently available for all supported 
applications.

When using autodiscovery with all databases:

1 When creating a new scenario, the autodiscovered database files icon 
appears in the master root directories column of the Framework 
window. Its exact name is an amalgam of the text autodiscovered, and 
the specific server type name. For example: Autodiscovered Exchange 
2000/2003 files.

2 To start autodiscovery, double-click the Auto-discovered icon in the 
master root directories column of the Framework window.
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Autodiscover Database Files for all Databases
4. The Autodiscovery screen displays all database directories and files. From 
this screen you can deselect any selected items from replication.

 

5. Click OK.

Note: Autodiscovery is possible only if the WANSync Engine is installed and 
running on the selected server.
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Select Replica Root Directories
Select Replica Root Directories
You must select the master directories before this function becomes available. 
For each master root directory you must define a replica root directory on each 
related replica.

Important! Special limitations apply to mapped drives or UNC paths 
(\\server\share). These path types are not supported as a source for real-time 
replication. However, they can be the target for data replicated in real-time, in 
which case, they can even support ACL replication. If these path types are used 
as the source, you are limited to scheduled synchronization only and open files 
are not synchronized.

To select replica root directories:

1. Click the replica server and then select the Directories tab. The selected 
master directories screen is displayed.
 62    WANSync User Guide



Select a Master Registry Key (Windows)
2. To replicate the master root directories to the same location in the replica as 
in the master, click on the rewind (left-facing double arrow) icon.

3. To select a different directory in the replica, double-click Enter directory 
here. WANSync connects to the replica server and opens the Browse for 
Directory window which displays the replica server’s directory (Browsing for 
a directory is possible only if the WANSync Engine is installed and running 
on the selected server).

4. Select a replica directory to hold the corresponding master directory. Repeat 
this for each master directory.

5. In order for the replication process to succeed, verify that the user under 
which the WANSync Engine is running has permission for each replication 
root directory.

Note: The replica root directory does not have to actually exist. You can 
enter the directory name by selecting the entry using the standard Windows 
conventions and WANSync creates it when the replication starts. 

Select a Master Registry Key (Windows)
To enable replication of Windows system settings (the registry keys):

1. Select the desired scenario.
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Select a Master Registry Key (Windows)
2. Select Edit > Enable Registry Keys Selection (or right-click in a blank area of 
the master root directories window (do not mark a directory) and select 
Enable Registry Keys Selection). A Registry entry icon appears in the master 
root directories section of the window. WANSync now replicates the Windows 
registry in addition to the selected files.

To select a master registry key:

1. Right-click the registry icon and select Browse and Select Registry Keys (or 
select Edit > Browse and Select Registry Keys). WANSync Manager connects 
to the master server and displays its local registry structure.
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Select a Master Registry Key (Windows)
2. Select the master registry keys that you want to replicate (browsing for 
registry is possible only if WANSync Engine is installed and running and 
WANSync Manager has a TCP connection to the selected server).

To remove a registry key:

Select a registry key in the root directories window. Right-click and select 
Remove Registry Key (or press the Delete key on the keyboard): the registry key 
is removed from the display.
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Specify a Replica Registry Key (Windows)
Specify a Replica Registry Key (Windows)
The number of keys defined for the master server determines the registry keys 
for each Replica. 

You must assign a name to the replica registry key, but this key does not have 
to exist. You can create the registry key on the fly, along with any sub-keys that 
are required. You can also browse for an existing registry key.

Use Same Key Names as Master Registry

To use the same key name as the master registry, click the rewind (double arrow 
pointing left) icon in the master root directories area.

Browse for the Replica Server’s Registry Keys

To browse for the replica server’s registry keys:

1. Double-click the registry icon to open the Browse and Select Registry Keys 
form. 

2. Select the desired replica registry keys or values and then click OK.

Note: Browsing for registry is possible only if WANSync Engine is installed 
and running and WANSync Manager has a TCP connection to the selected 
server.
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Set Master Server Properties
Set Master Server Properties
The property values determine the replication and synchronization settings for 
the scenario. They determine the entire scenario’s default behavior concerning 
spool directories, transfer rate, synchronization method, reporting, etc.

Each scenario is identified by its specific Product type, Server type and unique 
Scenario ID. The values of these items cannot be modified.

Note: The Framework window and its tabs (Statistics, Directories, Properties) 
are context sensitive and change whenever you highlight a different replication 
tree. 

A running scenario has a gray background, and scenarios that are not running 
have a white background.

To set master server properties:

1. Select the master server and click the Properties tab at the bottom of the 
Framework window. The Properties tab open.

2. Select or enter the appropriate values. Some values can be manually 
entered in an edit box field, while other values can be selected from a combo 
box or IP control by clicking the default value.
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Replication Data Values Table
Note: For HA File Server, the Synchronize Shares option is not present. The 
issue is handled under the Switchover tab.

Replication Data Values Table
This table lists the master properties, corresponding values, and brief 
explanations.

Property Values Explanation

Replication Mode Online Triggers real-time replication.

Changes are replicated continuously, in 
real-time, using the XOFS driver.

Assessment 
mode

Allows accurate bandwidth usage and 
compression ratio benchmarking, 
without actually replicating data. No 
replication occurs but statistics are 
gathered. A report is provided after the 
specific report interval is reached.

Scheduling Schedule: Servers are synchronized at a 
scheduled, fixed time. 

By User 
Request

Synchronization is triggered by a user 
running synchronization from 
WANSync Manager, or CLI.

Weekly 
Activity         

Hours

A dialog box opens for setting the 
synchronization timetable. After setting  
the scheduler, a short representation of 
the set hours are displayed.

For a more detailed look at the 
mechanism for setting the scheduling 
timetable, see Set Advanced 
Schedules.

On-file-close 
(content 
distribution 
scenario only)

Continuous replication using the XOFS 
driver, but changes to individual files 
appear on the replica server only after 
the file is closed.

Synchron- 
ization with 
file re- 
placement

On/Off Apply on-file-close algorithm during 
initial synchronization as well.
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Replication Data Values Table
Automatic run/ 
synchronization

On/Off Synchronizes any replica that has lost 
communication with the master for too 
long a time, and in the following cases 
(if the option is chosen):

If the master is rebooted, WANSync 
automatically re-synchronizes the 
master and the replica after the reboot.

If the spool overflows, WANSync 
automatically re-synchronizes the 
servers upon resumption of the 
connection.

Auto synchronization is never carried 
out if a scenario runs in a scheduling 
mode.

Automatic 
synchronization type

File 
Synchronization 
(Continual)

Block 
Synchronization 
(Continual)

Ignore 
same 
size/time 
files

See Replication Data Values Table for a 
detailed explanation of these values.

Run script before 
synchronization

On

Off

 
 
 
Script name

Selecting this triggers a script to run 
before each synchronization. 
Synchronization does not wait for this 
script to execute.

The full path to the script. 

Arguments Arguments to pass to the script 
specified in the previous property. 
Arguments are static values.

Run script after 
synchronization

On

 
Off

 
 
Script name

Selecting this triggers a script to run 
after each synchronization. 

The full path to the script.

Arguments Arguments to pass to the script 
specified in the previous property. 
Arguments are static values.

Stop database on 
run

On

Off

When set to On, if a database scenario 
(Exchange, SQL, Oracle) is running and 
the database is running on the replica 
server, WANSync stops the database 
services before running the scenario 
(does not apply to HA scenarios).

Script name The full path to the script.

Property Values Explanation
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Connection Values Table
Connection Values Table
This table lists the master properties, corresponding values, and brief 
explanations.

Arguments Arguments to pass to the script 
specified in the previous property. 
Arguments are static values.

Compress data On

Off

Compresses data before sending to 
Replica. Optimizes bandwidth and 
transfer time.

Maintain write order On

Off

Ensures data integrity in the replica at 
any moment. This is absolutely 
required for database and mail servers. 
If you are unsure — keep it on. Default 
is On.

Attach to open files 
on run

On

Off

Soft activation allows WANSync to start 
synchronization and replication of 
always-open files (like databases or 
mail servers) that were open before 
WANSync was started. If you are 
unsure — keep it on. Default is On.

Replicate NTFS 
compress attribute

On

Off

Replicates compress attribute of files or 
directories. Windows only. 

Replicate NTFS ACL On

Off

Transfers ACLs for files and directories 
during synchronization and replication. 
Windows only.

Synchronize Shares On

Off

If a directory has been set to allow 
sharing, then setting this option to On 
duplicates the property in the 
replicated directory. Windows only.

Property Values Explanation

1. Compress data is resource consuming, and impacts server performance. If the typical file format 
being transferred does not compress much, this option is a waste of processing power and time. 
Although the transmission bandwidth can be lessened, the overall replication time is a function of 
compressibility and available processing power.

2. Already compressed files such as .zip, .rar, .gz, .jpeg, etc., and any small file whose size is less 
than 512 bytes, are not compressed. 

3. To reduce impact on master server performance — activate this feature on the first level replica 
(not on the master).
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Spool Values Table
Spool Values Table
Data is kept in a spool directory on the host (master property) before it is 
transferred to the Replica. Normally, data is sent to the replica immediately. 
However, in some cases (depending on the server update rate and the 
bandwidth on the master-replica or Replica-Sub-replica link), data may remain 
in the spool awaiting transfer. If the spool size is limited then in some extreme 
cases, the spool might overflow. In this case, replication is stopped and resumed 
later. To avoid spool overflow, it is important to define a spool large enough to 
handle peaks in the update rate in the server, as well as network failures or leave 
it at the default value of Infinite. In addition, verify that the bandwidth is 
sufficiently large to handle the replication traffic.

Property Value Explanation

IP address IP Control Displays the IP address for the selected host. If the host 
name is changed, the IP address is updated. The host can 
also be changed by entering another IP address in this 
field. 

Port number <#> 25000 by default. This is the incoming port used for TCP 
communications. It can be changed to any unused port.

Fully qualified name Fully qualified name 
of the master host

This value is always synchronized with the value in the 
Switchover values pane, if a high availability scenario.

Property Value Explanation

Max spool size <#> or 0 for 
unlimited

If you wish to limit the maximum spool size, enter it here. Enter a 
0 for unlimited spool size. Note that, if you do enter a value, this 
space is used only if needed – it is not preallocated.

Min disk free size <#> Enter the free disk space threshold at which the system issues an 
error and stop replication.

Spool directory <text> The directory that holds the spool. The default directory is /tmp on 
Solaris servers and [WANSync Installation directory]/tmp on 
Windows.

The default Solaris spool directory /tmp is a swap directory located 
in memory. It provides better performance. DO NOT, however, use 
it for large spools!
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Script on Trigger File Table
Script on Trigger File Table
Normally, during continuous replication, changes made on the master server are 
simply mirrored to replica servers. In some cases in content distribution 
scenarios, it may be desirable for additional actions to be taken at the point that 
a certain file appears on the master server (an analogous function is available 
on the replica server as well). Such a file is called a trigger file since it triggers 
an action when it appears. The actual mechanism is to invoke a script 
immediately following the creation of the file on the Replica. Subsequent open 
or write events have no effect.

Reports Values Table

Property Value Explanation

Run script on 
trigger file

On

Off

Specifies whether or not special actions should be 
triggered via a script when a specified trigger file appears. 
When set to On additional options appear.

Trigger file The name of the file that triggers the script specified by the 
next property. The script is triggered at the point that the 
file creation event occurs.

Script name The full pathname of the script that is invoked when a file 
with the name specified in the previous property appears 
on the system.

Arguments Arguments to be passed to the script specified in the 
previous property. Arguments must be static values.

Property Value Explanation

Generate 
synchronization 
report

On

Off

Generate 
detailed 
report

On

Off

Specifies whether or not to generate a synchronization 
report.

Specifies whether or not to generate a detailed 
synchronization report.

Generate 
replication 
report

On

Off

Report 
timeout 
(min=1 
hr)

Generate 
detailed 
report

On

Off

Specifies whether or not to generate a replication 
report. Since replication is continuous, specifies how 
often to generate the report. 
 
Specifies whether or not to generate a detailed 
replication report.
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Reports Handling Values Table
Reports Handling Values Table

Report format HTML 
Text 
XML

 Type of output format for the report. If XML or HTML, it 
is viewable in a Web browser; if Text, you can open it 
via a text editor such as Notepad. XML is the default.

Report 
retention (days)

Unlmtd Specifies the number of days to retain replication 
reports.

Property Value Explanation

Property Value Explanation

Store reports on 
master

On

Off

Reports 
directory

Specifies whether or not to store reports on the 
master server.

Specifies path for the reports directory.

Send to Manager On

Off

Reports can be displayed on screen in the default 
editor or browser.

Destination reports directory can be set by the user.

Notify by email On

Off

Mail Server

Email address To

Email address 
From

Specifies whether or not to send reports by email to 
the specified address. 

Enter the mail server hostname or IP, destination 
email address, and source email address, to notify via 
email.

Execute script On

Off

Specify a script for WANSync to run whenever it 
sends a report.

Script Name  
+ Full path of 
report file  
+ Report type

Enter full path of script name to process notification 
via a script. WANSync runs the program with the first 
argument defining the full path of the generated 
report message file and the second defining the type 
of report (Replication or Synchronization).

Arguments Additional arguments to pass to the script specified in 
the previous property. Any arguments entered here 
follow the two arguments automatically sent by 
WANSync. Arguments entered here are static values.
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Event Notification Source Table
Event Notification Source Table
When an event occurs, it is possible to set the system to run a script or send an 
email notification. In order for this to work, the correct notification source must 
be specified.

Event Notification Values Table
If a notification source other than None has been selected in the Event 
Notification Source Table, you can set the properties defined in the following 
table to activate when an event occurs.

Property Value Explanation

Notification Source None Default

Manager The WANSync Manager notifies on events.

Master The master notifies on events. 

Property Value Explanation

Event Filter Lost Connection The TCP connection does not function, or a 
server went down, etc.

Queue overflow The quantity of data in the spool directory has 
exceeded its threshold value.

Other Any other error

Significant info Important information such as when 
synchronization is finished, etc.

Notify by email On

Off

Mail Server

Email address To

Email address 
From

Specifies whether or not to send reports by 
email to the specified address. 

Enter the mail server hostname or IP, 
destination email address and source email 
address, to notify via email.

Execute script On

Off

Specify a script for WANSync to run 
whenever it sends a report.

Script Name  
+ Full path of 
message file

Enter full path of script name to process 
notification via a script. WANSync runs the 
program with the first argument defining the 
full path of the generated message file.
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XO System Event Types
XO System Event Types

XO System Event IDs

Arguments Additional arguments to pass to the script 
specified in the previous property. Any 
arguments entered here follow the argument 
sent automatically by WANSync. Arguments 
entered here are static values.

Write to event 
log/syslog

Writes the events to the Windows event log 
or to the UNIX system log.

Property Value Explanation

Code Description Name

0 Informational XO_INFO 

1 Error conditions XO_ERR 

2 Action must be taken immediately XO_ALERT

3 Critical conditions XO_CRIT 

4 Warning conditions XO_WARNING 

5 Normal but significant condition XO_SIGNF_INFO 

6 Debug-level events XO_DEBUG 

Code Description Name

0 Informational XO_EVENTID_INFO

1 Error conditions XO_EVENTID_ERROR

2 Connection lost XO_EVENTID_LOST_CONNECTION

3 Reestablish connection XO_EVENTID_REESTABLISH_CONNECTION

4 XOFS queue overflow due to 
excessive number of changes

XO_EVENTID_XOFS_QUEUE_OVERFLOW

5 XOFS queue normalized XO_EVENTID_XOFS_QUEUE_OK

6 Unable to apply file change XO_EVENTID_APPLY_FILE_CHANGE_FAILED

7 Synchronization/verification 
finished

XO_EVENTID_SYNC_FINISHED
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Schedule Synchronization
WANSync master Server properties offer the following flexible scheduling 
capabilities:

Synchronization on selected days of the week and for specific hours in a 24 
hour cycle

Synchronization over selected periods (e.g., once every 36 hours) in a 7 day 
cycle

Exclusion of specific dates

To access the schedule, select Replication > Replication mode > Scheduling > 
Hours. The following figure shows a sample scheduling screen in which the solid 
blue rectangles indicate the days and hours scheduled for synchronization. The 
excluded dates area lists the specific dates on which synchronization is not 
performed.

8 All modifications during 
synchronization period are 
replicated

XO_EVENTID_SYNC_JOURNALS_FINISH

9 Previous 
synchronization/verification in 
progress

XO_EVENTID_SYNC_IN_PROG

10 Critical error that causes 
running scenario to stop

XO_EVENTID_RUNNING_ABORTED

Code Description Name
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Synchronize Hours

Selecting hours and days is done in the following manner:

1. Select a single rectangle (for a specific hour/specific day). Click the Set 
button to actually mark and enable that hour.

2. Select a column to set that hour for each day in the week. Click the Set 
button to actually mark and enable those hours.

3. Select a row to set each hour of that day in the week to synchronize. Click 
the Set button to actually mark and enable those hours.

4. Enter a valid number of hours in the field Every to mark a repetitive cycle. 
Click the Apply button to actually mark and enable those hours. 

5. More than one rectangle can be simultaneously set by clicking and dragging 
the mouse.

6. To unmark, use the same technique of marking, and click the Unset button.

7. Click OK to accept the settings, or Cancel to ignore any changes.

Important! If synchronization is running, and the next scheduled 
synchronization hour comes up, the new synchronization stops the current 
one and starts again from the beginning.
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Exclude Dates

Specific dates can be set for exclusion from synchronization:

1. Enter the date into the Excluded dates field, and click the Add button. 

2. To remove a date, select the entry, and click the Remove button. Multiple 
entries can also be selected by dragging the mouse over them.

3. Click OK to accept the excluded dates or Cancel to ignore any changes.

Set Advanced Schedules
Advanced properties allows you to set times that are not on the hour. You can 
also configure schedule intervals in units of minutes vs. hours in the main 
schedules screen.
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Set Replica Server Properties
To set replica server properties:

1. Click a replica name from the Replication Tree window.

2. Click the Properties tab. The Replica Properties window opens and displays 
the configurable properties and available values.

3. All available property values can be accessed via a mouse click or by moving 
the mouse over the value field. Select or enter the appropriate values.

Note: The windows and tabs (Property, Directories) are context sensitive 
and change whenever you highlight a different host in the replication tree 
(Master, Replica1, Replica2...).

Scheduled Tasks

Currently, the scheduled tasks available to you are Replica Integrity Testing for 
Assured Recovery and Suspend. For a general discussion of suspending 
replication, see Suspend Replication; for a discussion of Replica Integrity Testing 
for Assured Recovery, see About Assured Recovery.

You can automatically suspend replication to the replica server temporarily 
according to a schedule and a script; the script performs maintenance or some 
form of processing that does not modify the replicated data on the replica server. 
After the script completes its run, synchronization and replication are resumed. 
By default, scheduled suspension is Off. Note that stopping replication 
terminates a running script.

When Suspend is turned on, a Schedule property appears. Initially it displays as 
Not Set. Click on this value to set the schedule (see Set Advanced Schedules). 
Once a schedule is set, an additional parameter for the script to run appears. 
Enter the full pathname for the script.

Note: You cannot suspend replication during synchronization. You can only 
suspend Replication temporarily since changes are accumulated in the spool 
directory of the master or upstream Replica. Make sure that sufficient disk space 
is available to hold the changes while the replica is suspended.
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Replication Values Table

Property Explanation

Compress Compress data between this replica and the next replica. Use to 
off-load resource-consuming compression task from the master 
server. If the compression option is active for either the master or 
a replica higher up on the tree hierarchy, this option is 
non-functional

Keep deleted files During synchronization, do not remove files that were deleted 
from the master server. During replication, do not notify the 
replica when files are deleted in the server.

Bandwidth Usage The allowed incoming bandwidth. Default is unlimited.

Run script after 
synchronization

On

Off

Specify whether a script should be run immediately after the 
synchronization ends. If set to On, additional properties appear.

Script name Specify full pathname of script to run.

Arguments Specify any arguments to pass to the script in the previous 
property. Argument values must be static.

Run script before 
synchronization

On

Off

Specify whether a script should be run immediately before 
synchronization starts

Script name Specify full pathname of script to run.

Arguments Specify any arguments to pass to the script in the previous 
property. Argument values must be static.

Stop database on 
run

On

Off

When set to On, if a database scenario (Exchange, SQL, Oracle) 
is running and the database is running on the replica server, 
WANSync stops the database services before running the scenario 
(does not apply to WANSyncHA scenarios).
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Connection Values Table

Spool Values Table

Recovery Values Table

Property Explanation

IP address Displays the IP address for the selected host. If host name is changed, the IP address 
is updated.  
Host can also be changed by entering another IP address in this field. 

Port number Enter the TCP port number to use. The default used by WANSync is 25000.

Property Explanation

Max spool size Enter the maximum spool size allowed. This space is used only if needed – it is not 
preallocated. The default is Unlimited. To enter a value of Unlimited, enter a zero.

Min disk free 
size

Enter the free disk space threshold at which the system issues an error and stops 
replication.

Spool directory The directory to be used to hold the spool. The default directory is /tmp on Solaris 
servers and [WANSync Installation directory]/tmp on Windows.

The default Solaris spool directory /tmp is a swap directory located in the memory.

It provides better performance, however DO NOT use it for large spools!

Property Explanation

Delay Replication data can be delayed in the parent server (master or Replica) spool 
before sending it to this Replica. This is useful against data corruption or viruses.It 
enables stopping replication before corrupted or infected data is written to the 
replica data.

Delay replication 
for (min)

Delay time (min).

Data rewind Keeps undo information needed to rewind data in case of data corruption.  
Note that data rewind is enabled only for online replication (journaling).

Store for last 
(min)

I/O operations are recorded in the rewind journal for this number of minutes, and 
then discarded in FIFO order (default is Infinite).

Max disk size (MB) The maximum disk space allocated for the rewind journal. Once this size is 
reached, old records are discarded in FIFO order.
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Attempted Replacement Table

Script on Trigger File Table

Typically, during continuous replication, changes made on the master server are 
mirrored to replica servers. In some content distribution scenarios, you may 
want additional actions taken at the point when a certain file has been replicated 
from the master server to the replica server. Such a file is termed a trigger file 
since it triggers an action when it appears. The actual mechanism is to invoke a 
script immediately following the creation of the file on the Replica. Subsequent 
open or write events have no effect.

Property Explanation

Number of 
attempts

Enter the number of attempts to be made for replacing a modified file that is busy, 
and the timeout between attempts.

These options are relevant only for Windows servers. If changes were received for a 
busy file (opened as non-shared for read) these options define how many times and 
at what interval to attempt replacing this file with the one that has the changes.

If the file is not released before the last attempt is made, the change is lost and an 
error message is initiated.

Timeout (msec) The time between an unsuccessful attempt and the next attempt.

Property Value Explanation

Run script on 
trigger file

On

Off

Specifies whether or not special actions should be triggered via 
a script when a specified trigger file appears on the Replica. 
When set to On additional options appear.

Trigger file The name of the file that triggers the script specified by the next 
property. The script is triggered by the create event for the file 
on the replica server.

Script name The full pathname of the script that is invoked when a file with 
the name specified in the previous property appears on the 
system.

Arguments Arguments to pass to the script specified in the previous 
property. Arguments are static values.
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Reports Values Table

Reports Handling Values Table

Property Value Explanation

Generate replication 
report

On

Off

Report 
timeout 
(min=1 hr)

Generate 
detailed 
report On

Off

Specifies whether or not to generate a 
replication report. Since replication is 
continuous, specifies how often to 
generate the report. 

Specifies whether or not to generate a 
detailed replication report.

Report format HTML

Text

XML

 Type of output format for the report. If 
XML or HTML, it is viewable in a Web 
browser; if Text, it is viewable via a text 
editor such as Notepad. XML is the default.

Property Value Explanation

Store reports on 
this host

On

Off

Reports 
directory

Specifies whether or not to store reports on the replica 
server being configured.

Specifies path for the reports directory.

Delegate to 
master

On

Off

Reports can be sent to the master server of the current 
scenario, where it is handled according to the Reports 
Handling properties of the master. This is the default 
behavior if replication reporting is turned On for the 
Replica.

Notify by email On

Off

- Mail Server

- Email address 
To

- Email address 
From

Specifies whether or not to send reports by email to 
the specified address. 

Enter the mail server hostname or IP, destination 
email address, and source email address, to notify via 
email.
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Scenario Operations
The following subsections describe scenario operations.

Save Scenarios

There are two methods of saving, either per scenario or a global save of 
all scenarios:

1. Click the Save icon or select Scenario > Save. 

2. Click the Save All icon or select Scenario > Save All, to save all scenarios on 
the WANSync Manager.

Export Scenarios

To export a scenario:

1. Select Scenario > Export. This opens a standard Save As window. Name and 
save the desired scenario.

2. The scenario is saved as a *.xmc file. 

Import Scenarios

To import a scenario:

1. Select Scenario > Import. This opens a standard Open browse window. 
Locate the desired scenario and click Open.

Execute script On

Off

Specify a script for WANSync to run whenever it sends 
a report.

Script Name  
+ Full path of 
report file  
+ Report type

Enter full path of script name to process notification 
via a script. WANSync runs the program with the first 
argument defining the full path of the generated 
report message file and the second defining the type 
of report (Replication or Synchronization).

Arguments Additional arguments to pass to the script specified in 
the previous property. Any arguments entered here 
follow the two arguments sent automatically by 
WANSync. Arguments entered here are static values.
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2. The manager imports the scenario to the WANSync scenarios directory and 
opens it.

Download Scenarios

WANSync Manager can download existing scenarios from any server running the 
WANSync Engine. This option is useful when installing WANSync Manager on a 
new machine, or when scenario files on the WANSync Manager machine have 
been lost.

When recording is initiated for the first time on machines running the WANSync 
Engine, they receive a copy of the scenario in which they participate. These 
scenarios can then be downloaded.

1. Select Scenario > Download. 

The Download window opens.
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2. Enter the host name or the IP address of the server to which you want to 
connect and then click Next. 

3. WANSync Manager attaches to that machine and locates any scenarios that 
are there.

4. WANSync detects all scenarios and lists them in the Scenarios window. 

5. Select the desired scenario and click Finish. The scenario downloads to the 
WANSync Manager.

6. If you have a scenario named scen1 and try to download another scenario 
having the same name, WANSync prompts you to confirm the replacement: 
Replace scenario scen1?

7. Click OK to replace the existing scenario or click Cancel to cancel the 
download.

Set Switchover Properties (WANSyncHA Only)
This section shows the properties under the Switchover tab. It is available only 
to those who are licensed for High Availability.

Some properties apply only to certain server types (e.g., Exchange, SQL, etc.). 
For more information, please consult the specific operations guide. These guides 
are located in the doc directory of the WANSync installation directory.
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Active Standby vs. Master Replica

In an initial scenario, the master is the active computer, and the replica is the 
standby computer. The standby computer is continuously checking the state of 
the active one, in order to decide if to take over from the active computer.
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The first time the switchover happens, the replica that was on standby becomes 
the active computer, and the master reverts to a standby mode (assuming it is 
still operational). When the master (now the ‘standby’) is ready, a switchback 
process can be initiated where the master again becomes active, and the replica 
returns to its previous standby and monitoring role.

Switchover Table

The system continuously checks for a switchover situation (see Is Alive Table) 
and informs the user according to the defined notification possibilities. In case 
of a switchover situation, the Perform switchover automatically flag is checked 
to determine if there should be an automatic switchover, or only a notification 
of the situation. In the latter case, automated switchover may be triggered with 
the Perform Switchover menu command or toolbar button.

Hosts Table

Property Explanation

Switchover host name Name/IP of the replica host to which the master switches. You can 
choose only one Replica.

Any time this Name/IP, or master’s Name/IP, is changed, all the 
switchover properties are reset to their default values.

Perform switchover 
automatically

When this flag is checked, switchover is initiated automatically if the 
master server is down.

Run reverse replication 
scenario after switchover

After a switchover, this flag is checked to see if replication in the reverse 
direction should begin automatically.

If set to Yes, after a switchover, replication begins automatically in the 
reverse direction, but it starts in a suspended state. It is unsuspended 
only after the database on the current primary server has passed all tests 
typically performed in the Check DB properties in the Is Alive Table.

Property Explanation

Master fully qualified name Fully qualified name of the master host.

Replica fully qualified name Fully qualified name of the replica host.
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Redirection Table

Property Explanation

Move IP This redirection is applicable only when both the 
master computer and the replica computer are 
located in the same network segment.

Choosing Off or On affects the available options in the 
Check with for a Send ping request. See Is Alive 
Table.

Add 
IP/Mask…

IPs on the active computer that are moved to the 
standby computer during switchover are listed here. 
To set up:

Click the tree entry: Click here to add new 
IP/Mask

A window appears: Enter relevant IP/Mask data. A 
new entry is added to the list. Click for as many 
entries as you require. Note that:

1) The master IP address in the WANSync scenario 
must not be one of the IPs included in this list. 
2) On a Windows platform, if the Move IP or the 
Redirect DNS property is set to On, WANSync turns off 
the dynamic DNS registration for the master (the flag 
in the checkbox Register this connection’s addresses 
in DNS in the Advanced TCP/IP Settings window is 
disabled).

Redirect 
DNS

This redirection option is applicable when the master 
and the replica are located in different network 
segments or on the same segment.

On a Windows platform, if the Move IP or the Redirect 
DNS property is set to On, WANSync turns off the 
dynamic DNS registration for the master (the flag in 
the checkbox Register this connection’s addresses in 
DNS in the Advanced TCP/IP Settings window is 
disabled).

DNS Server 
IPs

List of IPs of DNS servers to update. 

WANSyncHA tries to update all servers listed, 
however, switchover is considered successful if any 
update is successful. 

To enter the value, click the tree entry: Click here to 
add new IP.
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DNS TTL Time To Live

The value is changed in the DNS Server for A-record 
that is updated.

AD 
integrated

Specifies if it is an Active Directory Integrated zone 
type. 
If the master DNS is on a Windows platform and 
integrated with Active Directory, set this flag to On.

DNS key 
filename (full 
path)

Full path of the file containing the DNS secure key

This field appears only when AD Integrated is Off.

Master IPs in 
DNS

List of master IPs in its DNS server.

The master's DNS record is updated during every 
switchover:

In the switchover from master to Replica, the 
addresses in the master's DNS record are replaced by 
the addresses of the replica (see property Replica IPs 
in DNS, just below). 

In the switchover from replica to master, the 
addresses are restored after reverting the master 
back to the active host.

To enter the value, click the tree entry:  
  Click here to add new IP

Replica IPs in 
DNS

List of replica IPs in its DNS server.

The master's DNS record is updated during every 
switchover:

In the switchover from master to Replica, the 
addresses in the master's DNS record are replaced by 
these addresses (see property master IPs in DNS, just 
above).

In the switchover back from replica to master, the 
addresses of the master are restored after reverting 
the master back to the active host.

To enter the value, click the tree entry: 
  Click here to add new IP

Property Explanation
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Switch 
computer 
name

This redirection option is applicable when clients use 
NetBIOS name resolution for their connections with 
the master. During the switchover, the replica 
computer is renamed to the master computer’s name 
and the master computer is renamed to a temporary 
name (if the master is alive). After switchback the 
names are restored. Both host name and the NetBIOS 
name are changed.

If the host name and the NetBIOS name are not the 
same, this option cannot be used.

Master 
computer 
name

NetBIOS name of the master computer. 

Replica 
computer 
name

NetBIOS name of the replica computer.

With Reboot After a switchover, if the flag is set to On, both the 
master and the replica computers are rebooted.

We strongly recommend that you set this flag to On.

Identify 
network 
traffic 
direction 
script

Required to fully support custom, or customized, 
redirection methods. Custom scripts or batch files are 
used to identify the active server. This script 
determines if the forward or backward scenario is run 
when the scenario is started. The script runs on both 
master and replica: the one that returns zero is 
active. If both return zero, a conflict is reported.

User-defined 
scripts

Allow the standard redirection methods to be 
augmented or replaced by user-defined actions in 
scripts.

Active to 
stand-by 
redirection 
script

On

Off

Script 
name

Full pathname of script to be run on the active 
(master) machine, if it is alive, in order to redirect 
clients to the recipient (replica) machine.

Arguments Arguments to be passed to the script specified in the 
previous property. Argument values must be static.

Stand-by to 
active 
redirection 
script

On

Off

Property Explanation
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Is Alive Table

WANSync continuously checks to see that the active host is up (according to 
Send ping request, Connect to DB, Execute Script, see below). These checks are 
made in scheduled intervals according to the Heartbeat timeout. 

Each script must reside in the same path and with the same name on both the 
master and the replica. Checking the status is interpreted as follows:

If there is an indication that the active computer is OK (alive), no new action 
is taken, and the system continues to check according to the scheduled 
intervals of the Heartbeat timeout. 

If there is an indication that the active computer is not OK (is not alive), the 
active computer is checked again at the next Heartbeat timeout for a 
maximum period of Is alive timeout. If no indication of the active host being 
alive is found within the allotted time, WANSync executes event notification 
(send email, etc. as per Reports Handling Values Table). Simultaneously, it 
checks whether or not to perform a switchover, as defined by the Perform 
switchover automatically value (see Switchover Table).

Script 
name

Full pathname of script to be run on the passive 
(replica) machine in order to redirect clients to it 
before making it active.

Arguments Arguments to be passed to the script specified in the 
previous property. Argument values must be static.

Property Explanation

Property Explanation

Is alive 
timeout 
(sec)

If the Standby host does not receive indication 
that the master host is alive during this interval (in 
seconds), switchover is initiated. The checks are 
performed at Heartbeat timeout intervals. 

Default is 300 seconds.

Heartbeat 
timeout 
(sec)

Interval (in seconds) for sending heartbeat 
requests (performing the checks below).

Default is 30 seconds.

Check with

Send ping 
request

Default is On.
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If Move IP is On: 
In this case, during the switchover, the IP is 
moved from the active computer to the standby. 
Therefore, the standby computer must check this 
IP continuously.

IP for ping: IP address to ping.

An ICMP request is made from the standby 
computer to the active computer.  
If no reply is received within two seconds, the 
active computer is considered non-operational.

If Move IP is Off: 
The IP is not moved from the active to the standby 
computer in case of a switchover. Therefore, 
define two IPs for ping.

IP for ping from master to Replica 
IP address to ping.

When the replica computer is the active host, an 
ICMP request is made from the master computer 
to the replica computer. If no reply is received 
within two seconds, the replica computer is 
considered non-operational.

IP for ping from replica to master 
IP address to send ping to.

When the master computer is the active host, an 
ICMP request is made from the replica computer to 
the master computer. If no reply is received within 
2 seconds, then the master computer is 
considered to be non-operational.

This script 
allows the 
normal 
checks to be 
augmented 
or replaced 
by user- 
defined 
actions in a 
script.

Connect to 
Shares

- or - 

Connect to 
DB

For File Server: 
When this property is set to On, WANSync 
connects to the active computer’s file server each 
Heartbeat timeout, and checks to see if the shares 
are available. 

For others (SQL Server, Exchange, Oracle): 
When this property is set to On, WANSync 
connects to the active computer’s database each 
Heartbeat timeout, and checks to see if the 
database services are running, and all databases 
are mounted. 

Property Explanation
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Actions Table

Each script must reside in the same path and have the same name on the master 
and the replica.

User defined 
script:

Check script 
on active 
host and 
check script 
on stand-by 
host

On

Off

These scripts allow the normal checks to be 
augmented or replaced by user-defined actions in 
a script. When set to On, WANSync connects to the 
computer once every Heartbeat timeout, and 
executes a pre-defined script. WANSync checks 
the return code to determine the result:

If the return value equals zero, the active 
computer is OK (alive)

If the return value is any value other than zero 
there is a problem 

Script 
name

Full pathname of script.

Arguments Arguments to be passed to the script specified in 
the previous property. Argument values must be 
static.

Property Explanation

Property Explanation

Application/Share 
Management

- or - 

DB Management
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Automatic If you want WANSync to manage shares 
on your file server or services on your 
DB or other application server, set this 
flag to On (recommended). WANSync 
then:

1. Autodiscovers the list of application 
(DB) services that must be 
managed.

2. Starts DB services on the active 
host (if they are not already 
running) and stops them on the 
standby host (if they are running) 
when you start the WANSync 
scenario.

3. Stops DB services on the active 
host and starts them on the standby 
host during the switchover.

4. Run DB services on the active host 
after reboot if a WANSync scenario 
was running previously. 

Start 
Application/Ad
d Shares script

-or-

Start DB script 

On

Off

If set to On, runs a script of 
user-defined actions to augment or 
replace the automatic actions above. 

Script name Full pathname of script.

Arguments Arguments to be passed to the script 
specified in the previous property.  
Argument values are static.

Stop 
Application/Re
move Shares 
script 

-or-

Stop DB script

On

Off

If set to On, runs a script of 
user-defined actions to augment or 
replace the automatic actions above. 

Script name Full pathname of script.

Arguments Arguments to be passed to the script 
specified in the previous property.  
Argument values are static.

Action on Success

Property Explanation
Creating Replication Scenarios    95



Recover Active Server
Recover Active Server
In certain circumstances, it may be necessary to forcibly make the master or 
replica server the active server without completing the data synchronization 
process. For example, if switchover occurred but no data was changed on the 
replica server. In this case you may even have newer data on the master server 
making it undesirable to synchronize data from the replica to the master server. 
WANSync allows for this option through a process called Recover Active Server. 
To use this option, ensure that the scenario is stopped, and select Recover Active 
Server from the Tools menu.

Important! While this option is the right choice in many situations, use it with 
caution. If used improperly data loss can occur. Normally WANSync will not allow 
switchover from one host to another until all data is synchronized. It is designed 
this way so users are not redirected to an out of date data set that then 
overwrites what may be a more current data set. When using Recover Active 
Server WANSync is forcing users to one server or the other with no regard as to 
which server has the correct data set. Thus, as an administrator, you must 
manually ensure that the server you are making active has the most up to date 
data set.

User-defined 
script

On

Off

If set to On, runs a script of 
user-defined actions following the 
completion of a successful switchover. 

Script name Full pathname of script.

Arguments Arguments to be passed to the script 
specified in the previous property.  
Argument values are static.

Property Explanation
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Note: Recover Active Server is not available if you are using the Switch 
Computer Name redirection method.
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Select either Make Master Active or Make Replica Active depending onto which 
server you want to force the active role.

Important! If a legitimate switchover in a disaster situation occurs and users 
are redirected to the replica server for any period of time, it is important to 
replicate all changes on the replica back to the master before making the master 
server active. Using Recover Active Server in such a situation results in loss of 
data. 
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Templates
Templates are a powerful facility for customizing WANSync for your own 
environment. Many applications allow the default values of individual 
parameters to be modified. Examples might be the default font to be used in new 
documents in Microsoft Word, or the default signature for new messages in a 
mail client application. Templates take this idea one step further.

Rather than provide a method to modify a single, global default value, templates 
offer the ability to create an entire scenario that can be used as the starting point 
for new scenarios in the future. These special template scenarios contain all the 
parameters of an actual scenario and all of them may be modified except those 
that clearly apply to a concrete, individual scenario (such as the hostnames of 
the master and replica servers).

The second important advantage of templates over a set of global defaults is that 
they allow different sets of defaults to be created for different types of scenarios. 
For example, the default values appropriate for your high availability Exchange 
scenarios are not identical to those for your non-HA file server scenarios. With 
templates, you can create default settings and maintain them individually for 
each.

Create a Template

Templates are simple to create and use. To create a new template, select 
Scenario > New Template. A New Template window opens. Select the scenario 
type. The new scenario template appears in the scenarios area under a folder 
named Templates. This folder does not appear in the scenarios pane until at 
least one template is created.

Note: Scenarios cannot be created from a template until the template has been 
saved. Changing parameter values in a template will not change the values of 
those parameters in a scenario created from it previously.
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Templates
As with any scenario, you have the opportunity to rename the template. This 
name is used as the base for generating default names of actual scenarios 
created using it.

Because a template is not associated with any actual servers, some values may 
not be changed, such as names of master and replica servers. Also, while default 
folder paths can be entered on the Directories tab, they must be typed explicitly 
rather than entered through a file browser. Almost all other parameters in the 
scenario, documented in the sections above, can be changed.

After creating the first scenario, the screen that appears when you create a new 
scenario changes to New Scenario. If you select the New Scenario icon, you can 
create a new scenario with the built-in default values. If you select the From 
Template icon, you can select one of the templates and a new scenario is created 
with all parameter values taken from that template. Alternatively, you can 
create a new scenario from a template in the templates folder by right-clicking 
on the template and selecting New. 
 100    WANSync User Guide



Chapter 6: Running the Replication 
Process
 

Replication continues after the servers have been synchronized. WANSync 
allows simultaneous synchronization and replication, i.e., synchronizing servers 
while files are in use and being updated, while simultaneously replicating any 
changes.

Initiate Replication
To initiate replication:

1. Click Run on the toolbar, or select Tools > Run. If the scenario was not set 
up correctly, the Verification results window opens, listing all the errors 
detected.

2. These errors must be corrected, and then Run can again be selected. 
WANSync then verifies that the configuration is compatible with your 
environment. The Run pane displays: Are you sure you want to run scenario 
"MS Exchange 2000/2003 Scenario?"

3. This pane displays warning and error messages resulting from its checks. It 
is important that you consider them carefully – even if they are warnings, 
rather than errors, they indicate conditions that are known to potentially 
cause problems with replication or switchover. If any errors are displayed, 
you cannot run the scenario. We strongly recommend that you contact 
support if you encounter either warning or fatal errors at this stage. 

4. The Advanced button opens an additional pane with detailed information 
about the checks performed to help diagnose problems. It is intended 
primarily for use by support to help you resolve any issues encountered 
installing and running the software.
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Initiate Replication
5. If the checks are passed or only warning messages are displayed, you are 
given the option to continue the run by clicking OK. The Run window opens 
with synchronization options.

6. Choose the desired options (see How Synchronization Works). In general, 
the default value is the most appropriate choice. 

7. - Click Synchronize to synchronize and start the replication.  
- Click Skip to start replication without synchronization.  
- Click Cancel to abort. 

Important! Do not skip synchronization unless you are absolutely certain 
that the master and Replicas are identical. Ignore same size/time files is 
valid only when either File Synchronization or Block Synchronization is 
selected. It should not be used in database scenarios. 

Run Mode

While replication is running, the WANSync Manager screen becomes gray when 
the running scenario is selected. No configuration change or editing is possible 
at this time. Statistics are shown in the Framework window on the far right. 
Events are recorded in the Events window on the bottom.

Important! No configuration or directory changes are possible during a run.
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Change Configuration during Replication
Change Configuration during Replication
You cannot make changes to the scenario settings, files or directories while the 
scenario is running. 

To make changes to the scenario files or directories: 

1. Stop replication by clicking the Run icon. This releases it from its ‘depressed’ 
state. The WANSync Manager screen background returns to its normal color 
and the functions of the Properties and Directories tabs again become active.

2. Make all necessary changes, and click the Run icon again. Replication 
restarts.
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Stop and Start WANSync Manager
Stop and Start WANSync Manager
After the scenario has been defined, and replication has started, the WANSync 
Manager can be closed. It must remain open only for real-time monitoring of the 
replication process. Closing the Manager does not stop the running scenarios. 
When it is opened again, it automatically uploads all the saved scenarios and 
displays their status.

Important! Even when the WANSync Manager is closed, it is possible to get 
notifications by mail or run user-defined scripts when important events or errors 
occur (see Event Notification Source Table and Event Notification Values Table).

Synchronization
The synchronization process can be manually activated at any time (whether 
replication is running or not).

1. Click the Synchronize icon on the toolbar or select Tools > Synchronize. The 
Synchronize window opens with the synchronization options.

2. Choose the desired options (see How Synchronization Works).

Manual synchronization is recommended in the following situations:

Before starting replication on servers with large amounts of data and a 
heavy update rate

After a lengthy network failure if automatic synchronization is not activated

After rebooting one of the participating servers if automatic synchronization 
is not activated

You can also set synchronization to run at pre-scheduled hours on specific days 
and excluded on specific dates.
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Suspend Replication
At times it may be necessary to suspend updates on a replica machine in order 
to perform system maintenance or some other form of processing that does not 
modify the replicated data there. It is not desirable to stop replication since this 
requires a full resynchronization afterward. The replication suspension feature of 
WANSync makes this possible. Replication may be suspended either manually or 
on a scheduled basis.

During the period of the suspension all changes are spooled on the master or on 
the replica located upstream of the suspended Replica. In other words, changes 
continue to be recorded for update on the suspended replica, but are not actually 
transferred until replication is resumed. Once replication is resumed, the 
accumulated changes are transferred and applied without any need to perform 
a full resynchronization of the data.

Replication may be suspended manually or on a scheduled basis. To suspend 
replication to a particular replica server manually, select the scenario in the 
Scenarios pane and then select the replica to be suspended in the Replication 
Tree pane. Finally, select Tools > Suspend Replication or press the pause button.

When you are ready to resume, simply press the pause button again, or select 
Tools > Suspend Replication a second time (the icon is shown in both places as 
depressed).

While replication is suspended, you may perform maintenance on the replica 
server, including reboot. It is very important, however, not to modify the 
replicated data in any way or a full resynchronization with the master is required.

You can issue a synchronization command while a replica is suspended; however 
it is performed only after ending suspension.

For scheduled suspension of replication, see Set Master Server Properties.

Important! It is imperative that you do nothing on the replica that changes the 
data in any way, including starting an application such as Exchange, MS SQL, or 
Oracle.

Note: You cannot suspend Replication during synchronization: You can suspend 
Replication only temporarily since changes are accumulated in the spool 
directory of the master or upstream Replica. Make sure that sufficient disk space 
is available to hold the changes during the time the replica is suspended.
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Difference Report
Sometimes, it is convenient to know the difference between a master and its 
Replica(s) at a certain point in time. The comparison is performed using the 
same algorithms that are used in the synchronization process, but no data is 
transferred. A difference report is generated for each replica and sent to the 
Manager at the end of the process. This can be produced at any time. 

Important! It is not recommended to initiate the difference report as data is 
being updated on the master as even a minimal time-delay to the Replicas can 
affect the report results.

To create the difference report:

1. Click the Difference report icon on the toolbar, or select Tools > Difference 
report. The Difference report screen opens with the same comparison 
methods as in the Synchronization method screen.

2. Choose the desired options (see How Synchronization Works).
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Difference Report
3. At the end of the process, a difference report is generated for each replica, 
and sent to the Manager.
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Chapter 7: Monitoring Replication
 

Replication can be monitored from the WANSync Manager once a scenario is 
running. Monitoring enables viewing state information, statistics and events. 
Connection status appears beside each host in the Scenarios window.

The Statistics tab provides information about the total amount of data per root 
directory, recorded data per Replica, and synchronization information.

The Events window displays information about significant events, warnings, and 
errors received from the host. This information includes the host name, the 
event time, and a brief explanation.

The various monitoring tools of WANSync enable easy control and monitoring of 
events in real-time. In addition, WANSync can store all events in its log. 

Once a scenario is loaded and running, you can monitor:

State information

Live statistics

Events

Reports

Server log files

In addition, some of the displays and reports feature the user names as Started 
by and Controlled by. These indicate, respectively, the user that initiated the Run 
for the specific scenario, and the current user that has control of the WANSync 
Manager, for that scenario.

Monitor Multiple Scenarios
The scenario pane shows the current status for all scenarios in one pane. You 
can customize the way the columns are displayed (View menu > Customize 
scenario view option) or right click in the scenario pane and choose the 
Customize scenario view option). By default, all columns except Current User's 
Rights and Started by are shown.
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State Information
State information is displayed beside each scenario name and beside each server 
in the replication tree, whenever a synchronization process has been started or 
completed, and whenever a replication process is underway. 

The state information includes:

A graphic indication next to the scenario name indicating the scenario is 
running, performing manual synchronization, or is idle. 

The number of significant events and errors displayed next to each scenario.

A graphic indication of whether or not the servers are connected (a gold 
crown over the master and a blue crown over the replica): if the connection 
to any of the participating servers is lost the server icon appears with a large 
red X marked over it. WANSync bypasses the problem and continues.

Live Statistics
Live statistics are displayed in two areas:

Replication Tree window

Statistics window

Replication Tree Window

The live statistics displayed in this area are:

Total data replicated from this host

Total number of files replicated from this host

Total data synchronized from this host

Total number of files synchronized from this host

Total (current) amount of data contained in the spool
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Live Statistics
You can also view the replication tree in the graphical view.

Statistics Window

This area displays live statistics:

Per root directories - total amount of data (in KB) changed in the root 
directories; the number of files changed, removed, renamed

Per replica - amount of data received by the replica; progress information 
on the file currently being transferred to the replica

Last synchronization statistics
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Live Statistics
Refresh Statistics Display Automatically

You can set a default frequency for automatically updating the state information 
and live statistics display.

Define the refresh rate:

1. Select Tools > Statistics > Refresh Rate to open the Refresh rate window.
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Live Statistics
 

2. Enter the desired refresh rate in seconds. The Scenarios window updates 
accordingly. WANSync Manager receives state information from all servers 
participating in the current scenario.

Refresh Statistics Display Manually

To manually initiate a refresh of the displayed information: 

Select Tools > Statistics > Refresh, or the Refresh Statistics icon, or F5 
(keyboard function key).

Performance Counters

There are several performance counters added to the standard MS-Windows set. 

To monitor these counters: 

1. Select Start > Run > enter perfmon. 

The Performance window opens. 
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Live Statistics
2. Click on the Add Counters icon (plus sign).

The Add Counters window opens.
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Live Statistics
3. Select XOsoftEngine from the Performance object dropdown menu and 
select Open Files from the Select counters from the list field.

4. Click Add and then click Close.

5. Select XOsoftEngine.

WANSync Scenario from the Performance object dropdown menu and select 
Bytes Sent/sec from the Select counters from the list field.
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The performance data is composed of two objects:

XOsoftEngine object, which consists of counters that monitor the running 
XOsoftEngine service

XOsoftEngine: WANSync Scenario object, which consists of counters that 
monitor WANSync scenario that is running on the XOsoftEngine service

The breakdown and descriptions are as follows:

Counter Name Description Counter Type

Open Files Shows the number of files 
open by the XOsoftEngine 
service.

PERF_COUNTER_RAWCOUNT

Total Threads Shows the number of 
threads used by the 
XOsoftEngine service.

PERF_COUNTER_RAWCOUNT
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Bytes Sent/sec The rate at which bytes are 
sent from the specific 
scenario to its immediate 
children. It includes all 
replication and 
synchronization data.

PERF_COUNTER_BULK_COUNT

Bytes 
Received/sec

The rate of bytes coming 
into the specific scenario 
from its parent or from the 
application by which it is 
managed if the host is a 
master. It includes all 
replication and 
synchronization data.

PERF_COUNTER_BULK_COUNT

Replicated 
Bytes/sec

The rate at which the 
scenario is processing 
replication data bytes. 

PERF_COUNTER_BULK_COUNT

Scenario Up 
Time

The elapsed time (in 
seconds) since the scenario 
was last started. This 
counter displays the 
difference between the 
start time of the scenario 
and the current time.

PERF_ELAPSED_TIME

Idle Time The elapsed time (in 
seconds) since the last 
update. This counter 
displays the difference 
between the last update 
time and the current time.

PERF_ELAPSED_TIME

Spool Size The current number of 
bytes that the specific 
scenario is using in its spool 
directory.

PERF_COUNTER_LARGE_ 
RAWCOUNT

% Spool Usage The amount of the spool 
size the specific scenario is 
using (the ratio of Spool 
size to the Max Spool size).

PERF_RAW_FRACTION

Registry 
Changes

The number of online 
registry changes.

PERF_COUNTER_RAWCOUNT

Changed Files The number of online 
changed file, including 
created files and folders 
and updated files.

PERF_COUNTER_RAWCOUNT

Counter Name Description Counter Type
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Read Only Web GUI
The primary WANSync Manager may only be used by one Administrator at a 
time. Opening the GUI locks it for the current user making simultaneous use 
impossible. This is required to prevent conflicts. To allow simultaneous 
monitoring by any number of administrators WANSync also offers a read only 
Web GUI.

To access the web GUI:

1. Open your browser to http://masterservername:25000.

2. Enter a user account and password with administrative permissions on the 
master server.

Removed Files The number of online 
removed files and folders.

PERF_COUNTER_RAWCOUNT

Renamed Files The number of online 
renamed files and folders.

PERF_COUNTER_RAWCOUNT

Synchronized 
Bytes

The amount of bytes 
changed in synchronization 
process. 

PERF_COUNTER_LARGE_ 
RAWCOUNT

Synchronized 
Files

The number of files 
changed in the 
synchronization process.

PERF_COUNTER_RAWCOUNT

Synchronized 
Registry Keys

The number of changes in 
the Registry due to the 
synchronization process.

PERF_COUNTER_RAWCOUNT

# of Threads The number of threads 
currently used by the 
specific scenario.

PERF_COUNTER_RAWCOUNT

Counter Name Description Counter Type
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Read Only Web GUI
Note: There is no need to refresh the browser; the GUI refreshes 
automatically. You can monitor all parameters, statistics, and events from 
this window. 
Monitoring Replication    121



Events
Events
The Events window displays messages and general information (for example, 
that a directory is synchronized, server is connected, synchronization 
started/finished, etc.). This information is received from the servers 
participating in the running replication scenario. The information includes the 
server name and time and shows important events or error messages in bold 
letters.
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Events
When you click on an event, you select the host from which the event was 
received — in the Replication tree window, the host appears highlighted and the 
right window shows its information (as per the Directories or Properties tab). 
This is the same effect as when selecting a host by clicking on it in the Replication 
tree window. All events received from the selected host are displayed in blue 
letters while all the other messages are displayed in black letters. When an event 
has been selected, it remains in black lettering with a grayed-out background, 
regardless if its host is selected or not.

Set the Events Filter

The displayable list of events can be defined in size (maximum list size), as well 
as the types of events that are to be displayed.

To set the event filter:

1. Select Events > Event Filter. The Event Filter screen appears.

2. Select the filtering options.

3. Enter maximum event list size. If the number of events received exceeds this 
size, old events are discarded every time a new event is received.

4. To cancel the event filter, click Events > Cancel Event Filter.
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Events
Freeze the Events List

The list of displayed events can be frozen to enable you to examine the list 
without being disturbed by new events arriving and shifting the events on the 
displayed screen. The events continue to be accumulated in the background. 
Once you unfreeze the list, all events received during the freezing period are 
immediately displayed.

To freeze the event list, select Events > Freeze Event List. 

To unfreeze the event list, select Events > Freeze Event List. 

Events History 

The events that are displayed in the WANSync Manager's Events area 
(on-screen) are also stored with the WANSync Engine that is the master for the 
current scenario. These events are accessible via the Event History option. The 
oldest events get overwritten to allow storage of the most recent data. The Event 
History is especially useful in case events are deleted manually (see Delete 
Events) and you want to see the most current list of events, or if another 
WANSync Manager runs with this scenario. This is available only while the 
replication is running. 

View Events in Separate Window

Sometimes, event messages are very long, exceed the Events area, and are cut 
off (visually). 

To display a single event in a separate window:

1. Mark an event.

2. Double-click, or right-click the marked event and select View Event in other 
Window, or select Events > View Event in other Window. 

A pop-up window displays the full message text of the selected event.
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View Incoming Events

WANSync Manager can notify you when an incoming event occurs.

1. To view incoming events as they occur: Select Tools > Pop-up on Incoming 
Event.

When an incoming event occurs, the WANSync icon in the task bar flashes. 

2. If you turn this option off, the minimized application in the task bar does not 
flash during an incoming event.

Acknowledge Events as Read

To acknowledge events as read:

1. Select an event by clicking on the appropriate line in the list (once it is 
marked, it is not displayed in bold). 

2. Or, right-click the desired event. 

A pop-up menu appears. 

3. Select Unmark All.

The bold formatting for the current event disappears. This can help to 
distinguish new (unread) events from old ones.
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Copy Events

To copy the text of the events for use in other programs:

1. Mark any number of events using Windows conventions.

2. Right-click in the Events area and select Copy, or select Events > Copy, or 
click ctrl+C.

You can paste the copied event texts into any program you wish.

Delete Events

Select the events to be deleted and press the Delete key on your keyboard.

Purge All Events from List

Select Clear All Events from the Events area pop-up menu (from right-click), or 
from the Events menu. All currently displayed events are cleared.

Reports
WANSync can generate reports on the replication and synchronization 
processes. These reports can be stored on the master, sent for display by the 
WANSync Manager, sent by email to a specified address, or they can trigger 
script execution. To set these options, see Set Master Server Properties. 
 126    WANSync User Guide



Reports
The reports that are generated are collected chronologically in a table that is 
output, by default, in XML format. XSL is used to transform the XML output into 
HTML that can be viewed in a browser (the XSL file used, report.xsl, is provided 
in the xml subdirectory of the WANSync installation directory. When displayed 
in a browser the table displays with links for accessing the outputs. (The Reports 
section in the Properties tab allows you to select XML, text, or HTML formats for 
reports.)

Note: The XLS file report.xsl in the xml subdirectory is required to view reports 
that are in XML format. It may be necessary to install this file in order for reports 
to be viewed on machines that do not have the WANSync directory installed.

Scenario Reports

If you select Tools > Reports > Show Scenario Reports from the menu bar the 
WANSync Reports window opens.

Synchronization Report 

Following synchronization, WANSync creates and opens a report listing the files 
that have been transferred. The first few lines (at the top) include the names of 
the master and the Replica(s) and the synchronization date. 

The summarized synchronization report includes a sum total of the removed and 
modified files as well as bytes transferred.
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The detailed report presents the complete listing of the files: time, file-path, 
name, and size.
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Reports
Replication Report

When this option is On (by default, it is Off), WANSync periodically creates 
replication reports (according to the set timeout). You can also view a report by 
selecting Tools > Reports > Replication Reports.

The reports include statistics on data replicated since the beginning of the 
replication process, as well as statistics on data replicated since the last report. 
The data includes the number of replicated bytes, number of files 
created/updated/removed/and renamed, and the number of errors. You can 
view either a summarized or detailed report. A summarized report looks like 
this:

Backward Scenario Report

A Backward Scenario report displays the information relative to that scenario:
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Reports
Difference Report

A Difference Report compares the difference between the master and the replica 
(see Suspend Replication).

Incoming Reports

You can view a compilation of incoming reports (except for Backward Scenario) 
automatically following synchronization by selecting Tools > Reports > Pop-up 
Incoming Report Window.
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Note: Deselect this option if you do not want to view incoming reports 
automatically.

The WANSync Reports window opens automatically.
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WANSync Engine Server Log Files
WANSync Engine Server Log Files
Log files are generated as a debugging mechanism, in order to trace the 
recording and rewinding procedure on the scenario host. When required, the 
WANSync Engine logs its activities in detail, i.e., every file received and every 
executed rewinding event. The generated log file is for use only by technical 
support. Note that this may downgrade WANSync performance. Therefore, 
generate only when necessary.

Select the Appropriate Scenario.

To select the appropriate scenario, click the Start Logging icon on the toolbar or 
select Tools > Start Logging.

View Log Files 

To view log files:

1. Select the appropriate scenario.

2. Select Tools > Get Log File or click the Get Log File icon. The latest log file 
opens in Notepad.
 132    WANSync User Guide



Chapter 8: Recovery
 

In case an event causes loss of master data, the data can be restored from any 
Replica. The recovery process is in fact a synchronization process in the reverse 
direction (from a replica to the master).

Important! You must stop replication in order to initiate recovery.

Recover Lost Data from Replica
To recover lost data:

1. Select the replica server to be used as source.

2. Select Tools > Restore Data or click the Restore Data icon. The Restore Data 
wizard appears.

3. Select the topmost option. If you want to remove files that exist only on the 
master, select Remove files that exist on master only.
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Recover Lost Data from Replica
4. Click Next. 

The Synchronization Method window is displayed.
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Data Rewind
5. Select the synchronization method and click Finish.

WANSync Manager builds a temporary reverse tree using the selected 
replica as the root, and the master as the terminating node. After the master 
recovery process ends, the temporary scenario is deleted, and the 
replication process can be restarted on the original scenario.

Data Rewind
This recovery method allows rewinding files to a point in time before they were 
corrupted. This process takes place on the replica server before the reverse 
synchronization process starts.

To activate this option, set Recovery/Data rewind to on (see Set Replica 
Server Properties).

1. Select the replica from which you want to recover and click the Restore Data 
icon. The Restore Data wizard screen opens (see Recover Lost Data from 
Replica).

2. Select one of the Rewind data options depending on whether you want the 
rewind data synchronized back to the master automatically or left on the 
replica only. If desired, select the Remove files that exist on master only 
option. 
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Data Rewind
3. Click Next.

 

4. Click Select Rewind Point.
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Data Rewind
5. Click Next.

The View Rewind Data window opens. This window contains a list of all undo 
points. These are files that have changed, been erased, been modified, etc., 
each time-stamped as a checkpoint, or point (in time). Additionally, the 
entire list can be exported to an Excel file by clicking the Export to Excel 
button.
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6. Rewind points can be filtered by type: file events, database events or 
Exchange events (if it is a database or Exchange replication scenario), all 
types. In addition, file events can be filtered using the same conventions as 
for filtering files during master root directories selection (see Filter Master 
Directories). Click Apply to activate the filtering. Only filtered rewind points 
are displayed.

7. Select the rewind point and click OK. 

The Rewind Point Selection window opens.
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Data Rewind
8. Click Next. 

The Synchronization Method window opens.
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Data Rewind
9. Select the desired recovery option and then click Finish.

At this stage, WANSync recovers the files according to the synchronization 
method chosen, generates a standard synchronization report, and lists the 
statistics. Once the files are recovered, you can return to using WANSync 
normally.
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Chapter 9: User Management
 

Windows manages all issues dealing with authentication (user identification), 
and authorization privileges, security levels, etc. 

Hierarchy, User-Levels, and Communication Protocol
User privileges are for communication between the Manager and the master 
host, or between the Manager and the master and the Replicas on its replication 
tree.

Windows authentication

– If the WANSync Manager or the master or replica are installed on NT4, 
NTLM is used for authentication. 

– If the WANSync Manager, master and replica are installed in the same 
domain or are in different domains with trusted relationships, WANSync 
uses Kerberos authentication. The authenticated user must be a domain 
user (not a local computer user). 

– In any other case, NTLM authentication is used .

Solaris or AIX authentication

– If WANSync is installed on Solaris or AIX, PAM authentication with 
encrypted username and password are used.

The following rights are available: Read-only, or Read/Write, where:

Read-only permits: viewing current status; viewing statistics; accessing and 
printing out synchronization and replication reports.

Read/Write also permits the above, plus full control: ability to create, modify 
and delete scenarios; ability to start and stop scenarios.

The Manager uses the current Windows user rights. If an action is attempted, 
and the user logged into the Manager does not have the correct authorization 
level, a window opens and asks for a username and password.
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Authentication
Every connection between the Manager and one of the hosts (Manager-Master, 
Manager-Replica, or Manager-Replica of a replica) is authenticated individually, 
with either a read/write or read-only privilege.

In determining the Manager’s rights to a host, the user is not immediately 
prompted for a username and password. 

Instead, one of the following scenarios takes place:

1. The Manager first attempts to authorize connection to a host using the 
current Windows user rights. 

2. The connection is authorized with read/write rights, if: 

The user has administrator rights on the computer where the 
master/replica has been set up and 

Master/replica host has been set up under the user account.

3. The connection is authorized with read-only rights if: 

The user is a known user in the domain where the master/replica has 
been set up and 

The user is a known local user on the machine where the master/replica 
has been set up.

4. The connection is not authorized and the following occurs: 

The authorization request icon appears on the left-hand side of the 
scenario, indicating that this is a master/replica for which the user does 
not have authorization.

If a scenario is selected, and it cannot be authorized with the current 
user, a window pops up and requests a username/password to be 
provided. When the new user and password is entered, the Manager 
again tries to authorize the connection with the master/replica.

The Manager maintains a stack of all user names/passwords entered 
during running and tries to authorize a connection by first trying each 
one of them. If the connection is still not authorized, a window pops up 
and requests authorization (enter the username as domain\username).

5. When the Manager starts or stops a scenario, it authorizes, based on the 
license, using the following two models: 

With master host only, a single authorization is made, or 

With master and all replica hosts, authorization is established for each 
host separately. This is done by stepping from one host to the next 
(through the tree hierarchy) and establishing authorized connections 
one at a time, meaning:

– No direct connection to a replica is established, or

– A connection to a replica is not established if the connection to the 
higher-level host is not authorized.
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Chapter 10: Installing WANSync on 
Microsoft (MS) Windows
 

This chapter describes how to install the WANSync components on an 
MS-Windows platform.

Initial WANSync Installation
Note: See Remote Installation Wizard for the preferred method of deployment 
in a Windows environment.

Installing WANSync components the first time is very straightforward. The 
installation package that is provided on a CD-ROM contains a file called 
Setup.exe that runs a standard MSI wizard.

This (non-intrusive) installation does not require reboot or application 
shutdown

The required level of INSTMSI.EXE is 2.0.2600.2 or higher -- otherwise, 
WANSync installation upgrades the Windows installer (this upgrade requires 
a reboot)

Standard prompts facilitate the installation. Your only major decision is on which 
servers to install the applications (WANSync Manager and WANSync CLI are 
installed together):

Install WANSync engine on both the master and replica servers

Install WANSync Manager on any computer that is used as a device to 
monitor and manage WANSync

The default installation directory (INSTALLDIR) is: \Program 
Files\XOsoft\WANSync. All executables, DLLs and configuration files are located 
in INSTALLDIR as is this manual and any other documentation included with the 
package.

During installation on the master and replica servers, you are prompted to 
enter the account under which the WANSync service runs

If you are running high availability scenarios, the account under which the 
WANSync service runs may require privileges in addition to those of the local 
system account (see the appropriate WANSyncHA operations guide for more 
information)
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Upgrade an Installation
A Windows user running the WANSync Manager requires Read-Write 
permission to the installation directory

The service logon account of the executing WANSync Engine requires 
Read-Write permission to the installation directory

Upgrade an Installation
There is no major difference between a new installation and an update to an 
existing installation. The setup executable automates most of the work, and the 
MSI wizard carries out all the required tasks to upgrade the application.

Note: Beginning with WANSync version 3.71.50 a valid maintenance license key 
is required to upgrade a WANSync installation. If a maintenance license key is 
not found or the maintenance has expired, WANSync will not allow you to run 
scenarios after an upgrade. If you have a valid maintenance contract (either 
included with the purchase of WANSync or purchased separately after the first 
year), but do not have a maintenance license key, please contact technical 
support.

Uninstall WANSync
Uninstalling WANSync is performed by a simple and standard activity through 
the operating system’s Add/Remove Programs in the Control Panel list.

The un-install does not remove the default directory storing the user 
generated .xmc scenario files that have been set up by the WANSync 
Manager. The directory is: INSTALLDIR\ ws_scenarios.
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Reboot WANSync
The un-install does not remove the master directory storing the 
user-generated reports. This directory is created if the Store Reports On 
master property is set to On. This target directory, located on the Properties 
tab, is user-definable. The default directory is: INSTALLDIR\reports.

Another property allows for storing user-generated reports on the Manager 
(if Send To Manager is set to On). It is not removed by an un-install. The 
directory is: INSTALLDIR\ ws_man_reports.

Reboot WANSync
After some upgrades or uninstalls you are prompted for a reboot: You must 
restart your system configuration for changes made to WANSync to take effect. 
Click Yes to restart now or No if you plan to restart later. We recommend that 
you click Yes to restart.
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Reboot WANSync
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Chapter 11: Troubleshooting
 

All events reported by WANSync include the following data:

Server producing the report

Date and time of the report

Event severity

Message describing the event

Error Conditions
WANSyncHA does not support DHCP assigned addresses. Using assigned 
addresses on the master can cause resources to go offline during a High 
Availability Run.

Error Messages
The following table includes error messages reported by WANSync servers, and 
the recommended action required to resolve the problem.
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Error Messages
Error Message Action

Cannot compress file filename Check that user under which the WANSync replicator 
runs has full permissions for the server spool 
directory

Check that there is enough free space in the spool 
directory. Change location of spool directory if 
necessary.

Cannot compress log file filename

Unable to compress journal file filename

Cannot create map data file tempfilename

Unable to create temporary file

Cannot copy file filename1 to filename2

Cannot save job to file filename

Server servername is dead – Cannot send 
email 

Check status of mail server set for error notification

Cannot connect to mail server servername

Failed sending mail to server servername 

Unable to move journal file filename to spool

Error building snapshot for dirname

Cannot create snapshot directory dirname

Error building snapshot for rootdirname: 
Unable to open output snapshot file

XOFS: Error mounting directory dirname Check that the directory exists on server

Check that the XOFS driver is installed

Error building snapshot for rootdirname: 
Unable to make file list of directory subdirname 

Check that the directory exists on server.

Check that the user under which the WANSync 
replicator runs has permission to open this directory.

Error building snapshot for rootdirname: 
Unable to build recursive directory list of 
directory subdirname
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Error Messages
Spool size limit exceeded. Current size: N Kb.

Once the problem is solved, the following 
message is received:

Spool size normalized. Current size: N Kb

If message is received from replica server increase 
spool size, clean disk and/or increase bandwidth 
available for the replication process.

If message is received from master server:

Case 1: Automatic synchronization is turned on. If all 
the replica servers are connected, then replication is 
stopped. Otherwise, spool is dropped and replication 
continues.

Case 2: Automatic synchronization is turned off. 
Replication is stopped.

Increase spool size, clean disk.

Disk almost out of space. Free space: N Mb

Unable to open file filename for sending, error 
errorno 

Check that the user has read permission on the file.

Unable to open file filename

Unable to write to file filename Check that the user has write permission on this file 
on the replica server.

Unable to execute event eventname for 
filename 

Synchronize the affected replication tree.

Received fatal error from XOFS Update rate is too high. WANSync replicator does not 
receive enough CPU time to process changes.

Check spool configuration.

Check /var/adm/messages for errors. Solve existing 
problems (possibly there is no disk space) and restart 
replication process.

XORG: Error adding registry path pathname Check indicated registry path exists.

Check that user under which the WANSync replicator 
runs has full permissions for this registry path.

Server servername is dead – Cannot send 
email 

Check status of mail server set for error notification.

Cannot connect to mail server servername

Failed sending mail to server servername 

Executing script scriptname failed with error 
errorno 

Check if the indicated script exists.

Check that the user under which the WANSync 
replicator runs has full permissions to execute the 
script.

Error Message Action
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Performance Messages
Performance Messages
The following table includes error and warning messages that announce 
performance degradation.

Server servername (IP IPaddress, Port 
portnumber). Authorization fail for user 
username 

User is not authorized to control WANSync Replicator 
on this servername or the password is incorrect.

Cannot connect to servername (port) Check network connectivity to the server

Error Message Action

Performance Message WANSync behavior

XOFS queue upper watermark is reached for 
dir_name due to excessive number of changes. 

Update rate is very high. Changes in this directory 
are still queued, but in order to unload CPU transfer 
of data to replica is suspended.

XOFS queue second watermark is reached for 
dir_name due to excessive number of changes. 

 Update rate is very high. Changes in this directory 
are still queued, but in order to unload CPU transfer 
of data to replica is delayed. 

XOFS queue lower watermark is reached for 
dir_name. 

Replication is resumed for the directory.

Too many open files.

Once problem solved the following message is 
received:

Number of open files normalized.

Replication continues to work but it slows down.

Processing unmount while some files are open. Cannot unload WANSync file system during process 
stop operation because some files are still open. 
Unloaded at first reboot. 
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Appendix A: Using the Command Line 
Interface (CLI)
 

This section provides a general introduction to the CLI tool, including a brief 
overview, descriptions of the hierarchic model, as well as basic workflow and 
launching instructions.

What is the Command Line Interface?
The Command Line Interface (CLI) is offered as an alternative to users that do 
not want to manage the replication process using the WANSync Manager graphic 
user interface (GUI). The CLI is an interactive shell that allows configuring a 
replication scenario and controlling and monitoring the replication process. All 
the scenarios that are managed by the CLI look and operate exactly as the ones 
that are managed by the Manager GUI, and they are saved automatically in the 
same default location: INSTALL_DIR/ws_scenarios.  

The CLI runs in two modes:

Interactive mode – this mode is similar to a UNIX shell, displaying a 
UNIX-like prompts. It enables you to perform all the functions that exist on 
the Manager GUI, besides generating and displaying reports (except for the 
Difference Report, which you can generate but not view).   

Non-interactive mode – this mode executes commands taken from the 
command line. It enables you to manage scenario using scripts or batch 
files. 
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What is the Command Line Interface?
Hierarchic Model

The CLI uses a hierarchic model to display the structure of replication scenarios. 
It uses a similar paradigm to a file system (each scenario can be thought of as 
a tree):

Key:

Component Description

WS This is the root of the tree. It contains the list of all 
available scenarios. 

<Scenario name> This is the root of the tree. It contains the list of all 
available scenarios. 

<Server name> Each scenario name contains a list of all servers 
participating in the replication scenario. Indentation is 
used to distinguish master servers from replica servers. 

DIR Each server name contains the DIR entry and the list of 
all server properties. Additionally, the master server 
contains the REPORTS and EVENTS entries. 
 152    WANSync User Guide



What is the Command Line Interface?
Workflow

The following workflow contains the main tasks that are preformed when 
creating and running a scenario using the CLI interactive mode:

REPORTS Contains the list of all selected directories for a 
replication. 

EVENTS Contains a list of reporting properties — what reports to 
generate and where to store or send them; whether or 
not to run a script; the location of the script. 

Component Description
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What is the Command Line Interface?
Open CLI 

Create 
Scenario 

Configure 
Master 

Configure Root Dirs, 
Events and Reports 

Configure 
Replica(s) Configure Dirs [and 

reports – optional] 

Run Scenario
(with / skip 

Synchronization)

Autodiscovery 
(Optional) 

Show Monitor, 
Statistics, Events 

Stop Scenario

Create 
Scenario

Open CLI

Configure
Master

Configure
Replicas

Run Scenario (w/skip)
Replication

Show Monitor, 
Statistics, Events

Stop Scenario

Configure Root Dirs,
Events and Reports

Autodiscovery
(Optional)

Configure Dirs (and
Reports - Optional)
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Run the CLI in Interactive Mode
Launching the CLI

To launch WANSync CLI in interactive mode:

Select Start > Programs > XOsoft > WANSync CLI or enter the following 
command from the Run command prompt: [full INSTALLDIR 
path]\ws_cli.exe. 

After opening the CLI, the following window is displayed:

To launch WANSync CLI in non-interactive mode: 

Open the command prompt and enter the desired commands. 

Run the CLI in Interactive Mode
There are two sub-modes of the CLI running in interactive mode: edit mode and 
run mode.

Edit mode - you can create and update replication scenarios. In this mode, 
the CLI promt looks like this:

Edit:WS> 

Using edit mode, you can:

– Create new replication scenarios

– Specify servers (master and replica) either by their server name or by 
their IP address

– Add directory/files to be replicated from master to replica(s)

– Set appropriate directories on replicas

– Set replication properties
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Run the CLI in Interactive Mode
– Run recovery

– Schedule synchronization to take place on specific dates and hours

– Start replication (and move to run mode)

– To work in edit mode, you need write permission in the CLI’s working 
directory.

Run mode- you can operate and monitor replication scenarios. In this 
mode, the CLI promt looks like this:

Run:WS>

Using run mode, you can:

– Stop a replication (and move to edit mode) or suspend it

– Synchronize servers

– Monitor the replication process

– Display events and error messages.

– Generate statistics and Difference report

– Set bookmarks

Interactive Mode Commands

The commands in the CLI interactive mode are divided into four groups: 

Browser

Edit

Manager 

Runtime

Browser Commands

In interactive mode, navigate the CLI structure using the shell-like commands 
such as cd and ls. For example, issuing ls at any level shows the entries at that 
level. 

The cd command moves to another level. For example, typing cd <path> 
moves the prompt to the sub-level <path>, or cd, to move to the upper level. 
In addition, all entries are indexed starting from 0. The index can substitute for 
<path> when navigating. The ls command displays indexes. For example, 
issuing cd 2 moves the prompt to the level with index 2.

Command Name Description

ls or dir [path] Lists all the entries at the current level, or at the level 
defined by the path.
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Run the CLI in Interactive Mode
Edit Commands

The CLI edit commands are:

cd <index> Changes current location to the level defined by the 
index. Such levels are emphasized in bold font. (The 
index number can substitute for the path.) 

cd [path] Changes current location to the level defined by the path. 
Such levels are emphasized in bold font. 

help or ? Presents a list of all the available commands. 

Help 
[command_name]

Presents a short description of the specified command.

Note: The help command can be accessed from any tree 
level or mode in the CLI (meaning, both the Run and Edit 
mode). 

history Presents a list of all commands entered since the CLI 
session began. 

history_save or hs Saves commands history in a file history.txt (saved in the 
CLI INSTALLDIR). 

quit or exit Exits the command line interface. 

Command 
Name

Description

add [path] 
<value> 

Adds a new server or directory to the replication scenario. The 
level at which the command was executed determines the 
added entity type: 

- When used at the WS level, it creates a new scenario. 

Note: 
Each scenario is saved in a separate file with suffix xmc. 

- When used at the server level, it adds a new replica. 

- When used at the DIR level, it adds a new directory for 
replication. 
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Run the CLI in Interactive Mode
Manager Commands

The CLI Manager commands are:

set [path] 
<value> 

Sets a replication property or directory name. 

Note: When setting a replication property, a series of 
options/prompts will appear according to the property's 
attributes. 

For example, the set mode command has three options: 
OnLine, Scheduling, and FileClose (i.e., Assessment 
mode). If you choose Scheduling, you're prompted to enter 
specific dates and times for the synchronization scheduler.     

rm or del 
[path] 

Removes server directory or scenario from the replication. The 
level at which the command was executed determines the 
type of removed entity. 

save Saves the changes to the scenario. 

Command 
Name

Description

Command Name Description

run Starts a replication for the current scenario. 

stop Stops a replication for the current scenario. 

sync Synchronizes the data on the replica servers with that on 
the master server. Usually you have to synchronize data 
before you start the replication process. Select the 
relevant synchronization method from the available 
options.

For Run mode only. 

recovery or rec Performs a recovery from the replica. You must be located 
in the relevant replica host for this command to work. 

import [path] Imports a scenario from a specified location.

export [path] Exports a scenario to a specified location.

autodiscovery Automatically discovers all database objects, related files 
and directories on the current master host. This procedure 
facilitates the directory selection for standard databases.
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Run the CLI in Interactive Mode
Runtime Commands

The CLI runtime commands are:

synconly Synchronizes data on the replica hosts with the master 
server, without running a scenario.

For Edit mode only.

difference or diff Generates a Difference Report that presents the 
differences between the master and the replica.

propagate_dirs Propagates the master root directories to specific replica 
hosts that are selected from a list. If the replica list is 
omitted, all existing replica hosts will be updated. 

server_type Displays a list of existing scenarios with their server types. 

timeout (in sec) Sets a time frame for the duration of a certain task, such 
as recovery. If the task is not completed by the scheduled 
time, an error message will be sent.  This command can be 
applied only to the following functions: suspend; resume; 
dbproc_start; dbproc_stop; recovery; difference report.

The time frame is set in seconds: timeout <number of 
seconds>

Note: After you use the timeout command once, the 
system saves the number of seconds you defined for it. 
When you next use the timeout command, the system 
applies the previous number of seconds automatically 
(unless you enter a different number). However, the 
system doesn't save the timeout value across sessions. 

Command Name Description

Command Name Description

monitor Displays the replication activity in real-time. 
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Run the CLI in Interactive Mode
events [all|clear|get|save] 

or 

msg [all|clear|get|save] 

Shows the list of replication events, including 
informational, warning and error events.

All - Shows history (up to 1000 events). 

Clear - Clears the events list.

Get - Downloads and shows all events stored on 
the master host. 

Save - Saves all stored events to the specified 
file.

switchuser 
[domain\username]

Changes the active user. 

statistics or stat Displays scenario statistic per host during a run. 

suspend [path] Suspends the replication process for a specified 
replica host (or for the current replica if no path is 
specified). 

resume Resumes a replication for the currently suspended 
host.

dbproc_start [path] Starts a replica integrity testing for assured 
recovery.

dbproc_stop Stops a replica integrity testing for assured 
recovery.

bookmark Sets a bookmark during a run. You are prompted 
to enter the bookmark type – regular or backup. 

show_bookmarks Displays the bookmarks that are on the replica.

Important! This command works only if the 
scenario is stopped.

Note: When using the show_bookmarks option 
from the Manager GUI, the displayed list contains 
both the user-defined bookmarks and the rewind 
points that were created automatically by 
WANSync. However, when using the 
show_bookmarks command from the CLI, the 
displayed list contains only user-defined 
bookmarks. 

Command Name Description
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Use the CLI in Interactive Mode
Use the CLI in Interactive Mode
The following example demonstrates how to define a replication scenario 
between hosts.

Define a Replication Scenario

The following procedure describes how to replicate all files from directory 
/dir/myrootdir on master myserver0 to directory /dir/ mybackupdir on replica 
myserver1.

Perform the following steps: 

1. Add a new replication scenario called demo.

Edit:WS> add demo 

2. [Optional] Depending on your license, you may be asked to Select Server 
Type Number.  

According to the displayed server list, enter the desired server number. 

3. Change location to the scenario level. 

Edit:WS> cd demo 

When a new scenario is added, a default master host and a replica host are 
created automatically. 

4. Rename the default master by using a valid host name or IP address. 

Edit:WS/demo> cd MasterHost 

Edit:WS/demo/MasterHost> set Host myserver0 

5. Rename the default replica by using a valid host name or IP address. 

Edit:WS/demo/myserver0> cd ../ReplicaHost 
Edit:WS/demo/ReplicaHost> set Host myserver1 
Edit:WS/demo/ReplicaHost> cd ..

6. Add an additional replica host using the host name or IP address. 

Add a new replica under the master:

Edit:WS/demo> add myserver0 myserver2

Add a new replica under the original (default) replica: 

Edit:WS/demo> add myserver1 myserver3 

7. Display a list of servers defined in this replication scenario. 

Edit:WS/demo> ls

You should see the following list:
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Use the CLI in Interactive Mode
8. Change the current location to the master server level. 

Edit:WS/demo> cd myserver0 

9. Display a list of replication properties of the master host. 

Edit:WS/demo/myserver0> ls 

10. Set the spool directory on the master (by default it is /tmp in UNIX, and 
Installation_Directory/WANSync/tmp in Windows). 

Edit:WS/demo/myserver0> set SpoolDirectory /opt/xohome 

11. Display an updated list of the master properties. 

Edit:WS/demo/myserver0> ls 

12. Specify the master directories and files to replicate. 

Edit:WS/demo/myserver0> cd DIR 
Edit:WS/demo/myserver0/DIR> add /dir/myrootdir

A message appears allowing you to exclude directories and files from the 
replica – You can specify the full paths to exclude.

13. Exclude files from the replication process.

Exclude full path [<enter> to cancel]: /dir/myrootdir/excl1

Exclude full path [<enter> to cancel]: /dir/myrootdir/excl2

14. Finish the definition of the excluded files.

Exclude full path [<enter> to cancel]: [click ENTER]

15. Display the list of files that are excluded from the replica. 

Edit:WS/demo/myserver0/DIR>ls

You should see the following list:
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Use the CLI in Interactive Mode
16. Change current location to the reports directory. 

Edit:WS/demo/myserver0/dir> cd ../Reports 

17. Display the list of reporting properties of the master host. 

Edit:WS/demo/myserver0/Reports> ls 

18. Set the timeout for sending reports to 10 hours. 

Edit:WS/demo/myserver0/Reports> set ReplReportTimeout 10 

19. Display an updated list of reporting properties of the master host. 

Edit:WS/demo/myserver0/Reports> ls 

You should see the following list:

20. Change the current location to the event notification. 

Edit:WS/demo/myserver0> cd ../Events 

21. Display a list of events notification properties of the master host. 

Edit:WS/demo/myserver0/Events> ls
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You should see the following list:

22. Set the master to notify events via email. 

Edit:WS/demo/myserver0/Events> set NotifyEvents ON 

Edit:WS/demo/myserver0/Events> set SendEmail ON

Edit:WS/demo/myserver0/Events> set MailServer mymail 

Edit:WS/demo/myserver0/Events> set MailTo admin@mymail;a@G.com

Edit:WS/demo/myserver0/Events> set MailFrom p@X.com 

23. Display an updated list of events notification properties of the master host. 

Edit:WS/demo/myserver0/Events> ls

You should see the following list:
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24. Change current location to the replica server level. 

Edit:WS/demo/myserver0/Events > cd ../../myserver1 

25. Set the spool directory on the replica. 

Edit:WS/demo/myserver1> set SpoolDirectory /opt/xohome 

26. Specify target directories on the replica server. 

Edit:WS/demo/myserver1> cd DIR 
Edit:WS/demo/myserver1/DIR> set 0 /dir/mybackupdir1

27. Set the other two replicas as well (created in step 5). 

Edit:WS/demo/myserver1/DIR> cd ../../myserver2 
Edit:WS/demo/myserver2> cd DIR 
Edit:WS/demo/myserver2/DIR> set 0 /dir/mybackupdir2

and 

Edit:WS/demo/myserver2/DIR> cd ../../myserver3 
Edit:WS/demo/myserver3> cd DIR 
Edit:WS/demo/myserver3/DIR> set 0 /dir/mybackupdir3

28. Change location to the scenario level. 

Edit:WS/demo/myserver3/DIR> cd ../.. 

29. Save scenario. 

Edit:WS/demo> save 

30. Start a replication (you may be prompted to authenticate the server after 
entering run — enter <domain\username> and <password>). 

Edit:WS/demo> run 

After typing run (and <enter>), you get the following: 

Synchronization Method: 
File Synchronization<File> 
Block Synchronization<Block> 
Choose method [<enter> to cancel]: 
Type File and <enter> 
Ignore same size/time files [Yes]? 
<enter> again and Replication begins. 
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Monitor and Edit a Running Scenario

At this point, the synchronization of the master and replica directories has 
started. The program starts to monitor the replication process. 

Now, do the following: 

1. Check synchronization status in the event log by clicking any keyboard key 
to stop the monitoring. Then, access events. 

Run:WS/demo> events 

2. Check that there are no error messages in the event log. Error events are 
highlighted. When the synchronization is completed, WANSync generates 
the following two events: 

Synchronization finished

All modifications during synchronization period are replicated 

3. Resume monitoring the replication process. 

Run:WS/demo> monitor 

The real-time monitor shows how many files were changed, removed or 
renamed, and how many Kbytes were transferred from master to replicas. 

4. Click <enter> on your keyboard to exit the monitoring. 

5. To make any changes to the scenario, you first must stop the replication: 

Run:WS/demo> stop 

6. The prompt changes back to Edit mode. 

Edit:WS/demo> 

7. Now, you can make changes to the scenario and save them to the file. For 
example, add another directory to be replicated.

First remove replicas 2 and 3 (in order not to have to add new directories to 
them as well): 

Edit: WS/demo> rm myserver2 

Edit: WS/demo> rm myserver3 

8. Now, add an additional root directory. 

Edit:WS/demo> cd myserver0/DIR

Edit:WS/demo/myserver0/DIR> add /home/data3 Edit:WS/demo/myserver0/DIR>cd ../../

myserver1/DIR 

Edit:WS/demo/myserver1/DIR> set 1 /home/data3 Edit:WS/demo/myserver1/DIR> save 

9. Now, restart the replication: 

Edit:WS/demo/myserver1/DIR> run
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Run the CLI in Non-Interactive Mode
In the non-interactive mode, CLI single-line commands can be used in scripts. 
In addition they can be used to configure a large number of hosts easily using 
standard input: ws_cli < scenario.txt. 

Typing ws_cli –h from a command prompt displays the command list and 
usage: 

CA XOsoft WANSync CLI v4.0.68 Usage:

-v version information

-I [hostname[:port]] - service state info

-r <scenario_name>

-U [domain\]username:password

-R <replica host name>

-m <run | stop | sync | events | status | synconly | suspend |

    resume | dbproc_start | dbproc_stop | propagate_dirs |

    bookmark | show_bookmarks | recovery | server_type | notify>

-T <timeout (sec)>

-b <bookmark name> (for bookmark setting)

-b <bookmark ID> (for recovery)

-t <bookmark type> = { all | regular | backup} (all - for show_bookmarks only)

-e noecho mode

-c <all | rewind | intact>

-d <external notification message>

-l <info | warning | error | critical> (notification message severity)

Flags (without value):

-F File Synchronization

-B Block Synchronization

-Y Ignore files with the same size and modification time

-P Manual database processing

-X Remove files that exist on Master only during recovery process

The following section provides a detailed explanation of each command.

Non-Interactive Mode Commands

The following commands are available in non-interactive mode:

Note: The commands that are used in the non-interactive mode perform the 
same functions as the ones that are in the interactive mode. For a detailed 
description of each command, see Interactive Mode Commands. 
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Command Description/Example

-v Displays version information. 

ws_cli –v 

-I [hostname[:port]] Displays all scenarios running on the specified 
server, the server role in the scenario and short 
statistics. 

ws_cli –I <host_name> 

-U [domain\]username: 
password

Sets authorized user for scenario (when 
applicable). 

ws_cli –r <scenario_name> –U 
uesrname:password

-r <scenario_name> Specifies the scenario name. Required for 
running a scenario.

ws_cli –r <scenario_name> –m run –F

-R <replica host name> Specifies the replica host name. Required for 
suspend and recovery actions.

ws_cli –r <scenario_name> –R 
<replica_host> –m recovery

-m <run|stop|sync|events| 
status|synconly| 
suspend|resume| 
dbproc_start| dbproc_stop | 
propagate_dirs| 
bookmark| 
show_bookmarks| 
recovery|server_type| 
notify> 

Runs the specified runtime command, as 
described below.

Note: Some commands require a flag. 

run Starts a replication for the current scenario.

ws_cli –r <scenario_name> –m run –F –Y [–U 
username:password]

stop Stops a replication for the current scenario.

ws_cli –r <scenario_name> –m stop [–U 
username:password]
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sync Synchronizes data on the replica hosts with the 
master server. For Run mode only.

ws_cli –r <scenario_name> –m sync –F –Y 
[–U username:password]

events Shows the list of replication events.

ws_cli –r <scenario_name> –m events [–U 
username:password] 

status Shows the status of the specified scenario.

ws_cli –r <scenario_name> –m status [–U 
username:password]

synconly Synchronizes data on the replica hosts with the 
master server. For Edit mode only.

ws_cli –r <scenario_name> –m synconly [–U 
username:password]

suspend Suspends a replication process for a specified 
replica host.

ws_cli –r <scenario_name> –m suspend –R 
<replica_host> [–U username:password]

resume Resumes a replication for the currently 
suspended host.

ws_cli –r <scenario_name> –m resume [–U 
username:password]

dbproc_start Starts a replica integrity testing for assured 
recovery.

ws_cli –r <scenario_name> –m dbproc_start 
–R replica_host  
[-P][–U username:password]

dbproc_stop Stops a replica integrity testing for assured 
recovery.

ws_cli –r <scenario_name> –m dbproc_stop 
[–U username:password]

Command Description/Example
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propagate_dirs Propagates the master root directories to specific 
replica hosts.

ws_cli -r <scenario_name> -m 
propagate_dirs [-R 
{[+]|-}<list_of_replicas>] [–U 
username:password]

<list of replicas> - this is the list of replicas, 
represented either by name (as specified in the 
scenario), by ip address, or by indexes (as 
displayed in the "ls" command output). The 
replica names should be separated by commas. 

bookmark Sets a bookmark during a run.

ws_cli -r <scenario name> -m bookmark [-b 
<bookmark_name>] -t { regular | backup } -T 
<number of seconds> [–U username:password]

show_bookmarks Displays the bookmarks that are on the replica 
server.

ws_cli -r <scenario_name> -R <replica host> 
-m show_bookmarks -t { regular | backup | all 
} [–U username:password]

recovery Performs a recovery from the replica.

ws_cli -r <scenario_name> -R 
<replica_host> -m recovery -c { all | 
rewind | intact } -b <bookmark_id> [–U 
username:password] [-X] [{ -B | -F}]

-X:  for file server scenario only.

-B/-F: for –c=all only.

server_type Displays a list of existing scenarios with their 
server types.

ws_cli - m server_type [–U 
username:password]

notify Sends a notification message that will appear in 
the message event list. You must add a severity 
level.

Ws_cli –m notify –r <scenario_name> -R 
<replica_host> -l { info | warning | error | 
critical} –d <message text>
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-b <bookmark name> Set a bookmark name (during a run).

[ws_cli –r <scenario_name> –m 
bookmark –b <bookmark_name> –t 
regular|backup]

-b <bookmark ID> Specifies a bookmark ID for recovery; use show 
bookmarks to see the ID for the recovery 
process.

[ws_cli –r <scenario_name> –m 
recovery –R <replica_host> –b 
<ID_no.> –c intact|rewind]

-t <bookmark type> = <all 
| regular | backup> 

Specifies a bookmark type; used in bookmark 
and show_bookmark commands.

Bookmark type: 

ws_cli –r <scenario_name> –m bookmark –b 
<bookmark_name> –t {regular|backup}

Note: 
you cannot use the All option when specifying a 
bookmark type. The All option is used for the 
show bookmarks command. Its aim is to filter 
the desired bookmark type. 

ws_cli -r <scenario_name> -R 
<replica_host> -m show_bookmarks 
-t { regular | backup | all } [–U 
username:password]

-T <timeout <sec>> Sets a time frame for the duration of a certain 
task, such as recovery. If the task is not 
completed by the scheduled time, an error 
message will be sent. Recommended for: 
bookmarks, suspend /resume, assured recovery 
and recovery processes. 

[ws_cli –r <scenario_name> –m 
recovery –T <no. of seconds> –R 
replica_host …]

Command Description/Example
Using the Command Line Interface (CLI)    171



Run the CLI in Non-Interactive Mode
-e For batch files. It decreases the files' output to 
facilitate the parsing process.

The -e can be added to every command. For 
example:

ws_cli –r <scenario_name> –m resume [–U 
username:password] –e

-c <all | rewind | intact> Specifies a recovery type:

all: Replace all data on master with the data on 
replica.

rewind: Rewind data on replica and replace all 
data on master.

intact: Rewind data on replica and leave master 
intact.

ws_cli -r <scenario_name> -R <replica_host> 
-m recovery -c { all | rewind | intact } -b 
<bookmark id> [–U username:password] [-X] 
[{ -B | -F}]

-d <external notification 
message>

Sends a notification message that will appear in 
the message event list. You must add a severity 
level.

ws_cli -r <scenario_name> -R <replica_host> 
-m notify –l { info | warning | error | critical } –d 
<message text> 

-l 
<info|warning|error|critical
>   

Specifies a notification message severity. Can be 
sent only with the external notification message 
(–d). 

The syntax is the same as in the –d command, 
above.

Command Description/Example
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Non-Interactive Mode Flags

The following flags (without values) are available in non-interactive mode: 

Sample Use of the CLI in Non-Interactive Mode

If you enter the following command:
ws_cli -r test -m run -F –Y 

the replication scenario named test runs and synchronizes using a file difference 
algorithm. It ignores files with the same size and modification time.

Note: By default, the test scenario file .xmc is located in the 
<INSTALLDIR>/ws_scenarios/ directory. You can change this destination 
directory in ws_rep.cfg file by removing the comment from the field 
ScenariosPath and entering the new full directory path. 

Flag Description

-F Files synchronization - synchronizes files by transferring modified 
and missing files.  

Add this flag upon using: 
–m run|sync|synconly|recovery

-B Block synchronization - synchronizes files by transferring only the 
differences that exist between files. 

Add this flag upon using: 
–m run|sync|synconly|recovery

-Y Ignores files with the same size and modification time from 
participating in the synchronization process. 

Add this flag upon using:  
–F 

-P Manual database processing.

Add this flag upon using: 
–m dbproc_start

-X Remove files that exist on the master only during the recovery 
process. 

Add this flag to the recovery process: 
-m recovery
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